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Preface

This guide is part of the documentation set for IT Process Centre (ITPC).

Audience
The range of ITPC modules creates the opportunity for four types of users, summarized in the following 
table:

Table 1   ITPC User Types and Responsibilities

User Type Responsibilities
ITPC User Responsible for carrying out specific business tasks using ITPC applications. 

Examples include:

• An office administrator submitting an online purchase request.

• HR personnel scheduling interviews for a potential hire.

• A sales representative responding to a customer request.

• An engineer reviewing a trouble ticket reported by a customer.

ITPC Manager Responsible for automating business processes in a particular business domain. 
BPM Portal’s Management module serves as the primary interface to ITPC for 
the ITPC Manager, enabling the manager to monitor, analyze, and control 
business processes. Also uses the Process Modeler for modeling and 
simulation.

Application Developer Responsible for creating customized applications for implementing business 
processes and developing interfaces associated with tasks. ITPC application 
developers may work closely with ITPC business managers to define the 
requirements of an application, and determine the business processes.

ITPC Administrator Responsible for configuring ITPC components, managing user/group profiles, 
and administering ITPC applications and utilities.
 7



Information on ITPC Documentation
IT Process Centre (ITPC) documentation contains information for the entire range of ITPC users. In the 
following table, we recommend the guides that are most relevant to each type of user.

Table 2   ITPC Documentation

If you are the… Read the…
ITPC User BPM Portal User’s Guide

Quick Start Guide
Terminology Guide
Tutorial Guide

ITPC Manager BPM Portal Manager’s Guide 
BPM Portal User’s Guide
Terminology Guide
Tutorial Guide

Application Developer API Reference Guide 
Application Developer’s Guide
BizLogic Developer’s Guide
BizPulse User’s Guide
BizSolo User’s Guide
BPM Portal Manager’s Guide
BPM Portal User’s Guidea

BPM Studio User’s Guide
Clustering Guide
Customization Guide
Managed Adapters Guide
Quick Start Guide
Terminology Guide
Tutorial Guide
Web Services Developer’s Guide

a. Demonstrates how to thoroughly test ITPC applications.

ITPC Administrator BizPulse User’s Guideb

BPM Portal Administrator’s Guide
BPM Portal Manager’s Guide
BPM Portal User’s Guide
Installation Guide
Managed Adapters Guide
Terminology Guide
Troubleshooting Guide for Administrators

b. Refer to the sections detailing BizPulse Admin.
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Conventions Used in this Manual
This document uses the following conventions and terminology notations.

Product Support Contact Information
If the product documentation does not provide a solution to your specific issue, or if you need clarification 
on the issue, please contact the EMC Product Support Team. You can contact the team through the Internet, 
e-mail, telephone, or by postal mail. 

To enable us to quickly answer your questions, please have the following information available:

•   Your name, installation site address and the license key for EMC software.

•   Your ITPC version and build number.

•   Your operating system, application server and browser, with version and service pack details, if any.

•   Your database management system and version, and information on JVM and JDBC used.

Where to Get Help
EMC support, product, and licensing information can be obtained as follows.

Product information — For documentation, release notes, software updates, or for information about EMC 
products, licensing, and service, go to the EMC Powerlink website (registration required) at:

http://Powerlink.EMC.com

Technical support — For technical support, go to EMC Customer Service on Powerlink. To open a service 
request through Powerlink, you must have a valid support agreement. Please contact your EMC sales 
representative for details about obtaining a valid support agreement or to answer any questions about your 
account.

Table 3   Conventions in this Manual

Convention Purpose
bold Indicates titles of command buttons, check boxes, options, lists, dialog 

boxes and portal page names.

bold italic Represents notes that alert you on specific ITPC elements and similar 
advisory information. 

italic Indicates directory paths, file names and book titles.

monospace Represents code segments or examples.

backward slash “\” Indicates the path in Windows environment. For UNIX environment, 
replace with forward slash “/”

ITPC_HOME or %ITPC_HOME% Represents the installation directory of ITPC.
Preface 9 Conventions Used in this Manual
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Your Comments
Comments and suggestions about our product documentation are always welcome. 

To provide feedback:

1 Go to: http://Powerlink.EMC.com

2 Click the Feedback link.
Preface 10 Your Comments
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Chapter 1

An Overview of ITPC

IT Process Centre (ITPC) is a comprehensive business process management platform, that enables 
companies to quickly transform their business processes into flexible and manageable Web applications, 
distributed over intranets, extranets, and the Internet. 

Figure 1   ITPC Overview

ITPC addresses every stage in the business life cycle: Define, Integrate, Deploy, Monitor, Analyze, Improve, 
and Control. By adopting an end-to-end approach, ITPC incorporates all the key elements required to meet 
the ever-changing demands of e-business while providing customers with confidence for e-business success. 
Providing integrated management tools, ITPC lets customers monitor operations proactively, modifying 
automated processes on the fly based on changing external operations online.
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ITPC Components
ITPC is a suite of integrated components that enables you to easily build intranet, extranet, and Internet 
applications and manage your e-business. ITPC consists of the following components: 

Figure 2   ITPC Components

Table 4   ITPC Components

Component Description
BPM Portal
Home

The Home module of BPM Portal is the primary interface for ITPC Users, enabling them 
to interact with ITPC applications. Users can complete entries to various tasks and 
applications, and link to the support infrastructure required to achieve these tasks.

BPM Portal 
Management

The Management module enables ITPC Managers to query, report on, and control 
processes and resources, and is only visible to ITPC Managers.

BPM Portal 
Administration

The Administration module enables ITPC Administrators to modify configuration 
parameters, manage user/group access control, and install/uninstall ITPC applications.

Web Services This component allows ITPC application developers to; a) publish their applications as 
Web services, and b) find and convert other available Web services on the Internet into 
ITPC applications.

BizSolo This component provides a framework for developing and implementing Web-enabled 
workflow applications.

BPM Studio This is the primary application development tool for ITPC, which provides an 
Eclipse-based integrated development environment in which users can create ITPC 
applications, processes, Web applications, and rule files.

Process 
Modeler

This tool is used to design templates for basic business processes, and to run simulations 
of processes and individual worksteps. Users can also save or retrieve processes from 
the ITPC process repository.
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How ITPC Works
The following figure provides an overview of the interaction between ITPC components.

Figure 3   How ITPC Works

BizLogic This is a flexible, lightweight, scalable workflow process engine for intranets, extranets, 
and the Internet.

BizPulse This open, event-driven rule engine is used to formulate and enforce policies in business 
applications.

Table 4   ITPC Components

Component Description
An Overview of ITPC 13 How ITPC Works



The following explanations correspond with the labels shown in Figure 3, and describe how the components 
operate.

A.   BPM Studio and/or Process Modeler provide an integrated development environment (IDE) for 
ITPC, where you can design and deploy business processes. The application developer designs a 
process template in the IDE that reflects the business flow and other business process requirements. 
ITPC then generates an *.spt or *.swt file for the process template. If desired, business rules for the 
process template can be defined using the Rule Editor, a BizPulse component that is launched with 
BPM Studio.

B.   The Web Container specifies a run time environment for servlet-based portals that include the BPM 
Portal, BizSolo and Web Services. The BPM Portal provides user interfaces for the Home, 
Management, and Administration modules.

C.   Once the process template is defined, ITPC Administrators use the Administration module to install 
the process on the BizLogic server. ITPC Administrators can also configure ITPC components, 
manage user/group access control, and publish ITPC applications as Web services. Once installed, 
users access applications through servlets that pass the requests over an RMI/IIOP connection to 
the BizLogic server within an EJB Container. 

D.   The EJB Container provides a run time environment that executes and manages Java-based 
program components that run on the server side of a client/server network. Within the EJB 
Container are the BizLogic server and BizPulse server.

E.   The BizLogic server writes events to event tables in the database. Each BizLogic process uses 
JDBC to connect to database server as well as store events in the database. Within the BizLogic 
server, BizStore uses JDBC to connect to the database server process and retrieve the events 
deposited by the BizLogic process.   BizStore interprets the events and populates the process tables. 
These populated tables are used by BPM Portal modules.

F.   Once the process template is installed as an ITPC application, ITPC Users use the Home module to 
access applications, obtain information to perform their tasks, and launch the application to start 
process instances from the BizLogic server. 

G.   Once the process template is installed as an ITPC application, ITPC Managers use the Management 
module to (depending on access privileges) launch the application to start process instances, 
monitor execution of process instances, and create reports. Servlets receive manager requests and 
pass them onto the BizLogic server over an RMI/IIOP connection. ITPC Managers use the Report 
Builder to define management reports that retrieve information through JDBC to the database 
server. 

H.   BizPulse is a rule-based event/message processing server that loads application rules and executes 
them against the BizLogic and/or external events/messages. This server persists data in the 
database for recovery and with the help of JDBC connects to the database.

I.   Managed Adapters exchange information between ITPC applications and external applications by 
converting ITPC-specific protocol to the protocol of an external system such as a database or ERP 
system. When users add a Managed Adapter to a workstep, they can define complex mapping 
between ITPC dataslots and adapter inputs/outputs of the external application. At run time when the 
workstep is executed, the Managed Adapter sets the adapter inputs and configuration, and maps the 
outputs to the appropriate output dataslots.

J.   BizSolo is a run-time component that executes the presentation flows. This component provides a 
Model, View, Controller (MVC) paradigm for developing presentation flow-based applications and 
executing them in a Web container.
An Overview of ITPC 14 How ITPC Works



K.   ITPC’s Web Services component allows BizLogic and BizSolo applications to be published as Web 
services. 

L.   The relational database management system serves as a persistent store for all ITPC data storage 
needs. The BPM Portals and servers connect to DBMS using the JDBC driver.

ITPC User Types
There are four user types within ITPC:

•   ITPC Users. ITPC Users use ITPC applications to coordinate specific business tasks with another 
department within their company, with another company within their organization, and/or with a 
business partner in another organization. The Home module in BPM Portal serves as the primary 
interface in which ITPC Users run ITPC applications.

•   ITPC Managers. ITPC Managers are typically experts in a particular business domain, such as 
Quality Assurance or Human Resources. They might need to work with managerial personnel from 
other groups in automating some of the business procedures that these groups share. The 
Management module in BPM Portal serves as the primary ITPC interface for business managers to 
coordinate and integrate business processes, enabling them to exchange information with each other, 
and to share functionality over such standard communication protocols as the Internet or e-mail.

•   ITPC Application Developers. ITPC Application Developers are responsible for analyzing 
business processes and developing interfaces associated with tasks or processes creation. 
Application Developers are often not domain experts themselves, but work closely with ITPC 
Managers to define the business process and determine the requirements of an application. 
Application Developers use BPM Studio or Process Modeler to define the business process; the 
resulting process template file is tested, simulated, deployed and run as an ITPC application.

•   ITPC Administrators. ITPC Administrators are responsible for configuring ITPC components, 
managing user/group profiles and access control, and installing/uninstalling ITPC applications. The 
Administration module in BPM Portal serves as the primary ITPC interface for ITPC Administrators 
to administer ITPC applications.

All ITPC user types can communicate by using one or more ITPC applications and/or by communicating 
between ITPC applications and external applications. Examples include:

•   A QA Department manager requesting the Human Resources Department to approve the hiring of a 
QA Engineer.

•   HR personnel coordinating interview scheduling with a regional office in another state.

•   Engineers collaborating with a business partner’s Engineering Department to develop specifications 
for an application.
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Chapter 2

Getting Started

IT Process Centre (ITPC) provides primary Web-based user interface in the form of BPM Portal. It is a 
complete portal through which you can interact with ITPC applications. 

When you log into BPM Portal, it displays the Home module tab for all users, irrespective of your user type 
and your user permissions. As an application user, you can display and modify tasks assigned to you, and 
manage your preferences. It also displays other tabs in addition to Home. However, access to other modules 
depends on your user type and permissions.

If you have ITPC Manager rights, the Management module is also available to you, where you can query, 
report, and control processes and resources for users. 

If you also have administrative rights, in the Administration module, you can modify configuration 
parameters controlling ITPC operations, manage ITPC components, and install/uninstall applications.

Note:    Though all modules are shown to you in the figures, you can access only those modules for which 
you have access rights. 
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Figure 4   Overview of BPM Portal

This chapter describes how to log into and out of the BPM Portal, the screen layout, and how to explore the 
Home module’s interface. As the interface is uniform for all modules, this information is helpful for other 
modules also.

Logging In
To access BPM Portal and use it, you need to log in to it. Your ITPC Administrator typically adds you as a 
new ITPC User, and assigns you a User Name and Password. To log in to BPM Portal, you need to use this 
User Name and Password.

As an ITPC User, 
view your tasks and 
instances.

As a Business Manager, 
control your processes 
and resources.

As an Administrator, 
configure and manage 
components and users.
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To log in to BPM Portal:

1.   Start the Login page according to your platform:

If you are logging in for the first time, then the Login page will be displayed as shown in the 
following figure. 

Note:    If you log in after a session timeout, then an appropriate message is displayed on the Login page.

Figure 5   BPM Portal Login Page

Note:    If you are using a theme other than the default one, then the screens will look different than shown 
in this document. For more details, see Using Themes on page 19.

Table 5 Logging in to BPM Portal

Using... Perform the following...
Windows 2000/
XP

From the Start menu choose Programs > EMC > ITPC 2.1 > Login to BPM 
Portal if you are using the installation machine. Otherwise enter 
http://machine_name.domain.com:port_number/sbm/bpmportal/login.jsp in 
your browser.

UNIX Enter http://machine_name.domain.com:port number/sbm/bpmportallogin.jsp 
in your browser.
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2.   Type your User Name and Password, and click Login. 

BPM Portal authenticates your User Name and Password and by default, displays the Task List 
page, as shown in the following figure.

Figure 6   Task List 

As a typical ITPC User, you will have access only to the Home module. Other modules to which 
you may have access are displayed along with Home, as additional tabs depending on your user 
type and user permissions.

Note:    You can change your password any time by using Home > Profile.

Using Themes
ITPC provides five predefined themes for BPM Portal and for applications in the portal. Your ITPC 
Administrator can select one of these themes as the presentation for your portal; and can select the same or 
another theme for the presentation used by applications in the portal. 
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Figure 7   Themes 

All figures in this document are displayed with theme05, which is the default theme. For more details, see 
Customization Guide.

theme05

theme01 theme02

theme03 theme04
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Exploring BPM Portal
When you log in to the BPM Portal for the first time, you will see the default Home tab, with the Task List 
page listing tasks assigned to you, as shown in Figure 8.

Note:    Use the Profile menu to select the language you prefer and use the Preferences menu to select a 
filter that sets the page's display. After configuring the Home tab, your selections are displayed 
the next time you log in to BPM Portal.

Page Layout

The terminology used for a typical BPM Portal page is explained below.

Figure 8   Default Home Page 

The main areas of a page are:

•   Global links: Located at the top right corner of every page, these links are available at all times 
during the session. 

•   Module tabs: For your convenience, features of different modules are grouped in sections. All 
features of a particular group are located in its own Module tab.

•   Module menus: Each tab has a set of specific menus. 

•   Page name: This shows the current page name. At the right side, a welcome message is displayed 
with the date when you logged in.

•   Link trail: This shows the pages you navigated through to reach the current page. You can click any 
link in the link trail and go back to that page. If you click a link in the link trail without first saving 

Global
Links

Module
Tabs

Module
Menus

Page
Name

Command
Button

Workspace
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contents of the current page, the data in the current page will not be saved. 

•   Workspace: Your data is displayed in this area. Generally it is displayed in one of the following 
ways: 

• Form: This lets you interact with the portal. Typically, forms contain text boxes, check 
boxes, and options that help you enter data. Forms can be in read-only or editable mode 
depending upon the contents and access privileges.

• List: This lets you view your data in a tabular format. Typically, lists contain filter bars, 
search options, and page controls that manage which data is displayed and how it should be 
displayed.

•   Command buttons and Links: The commands that help you interact with the data are represented 
by buttons. Buttons that help you accomplish some task but do not change the data values are 
typically located below the link trail. The links are located beside the buttons. Buttons that operate 
on the data shown in the current page and change their values are located below the workspace.

Keyboard Shortcuts

BPM Portal provides the following keyboard shortcuts to access its various module menus and menu 
options. 

Table 6   Keyboard Shortcuts

Module Keys Menu / Menu Option
Home CTRL+SHIFT+T My Tasks

CTRL+SHIFT+M My Instances

CTRL+SHIFT+H My Alerts

CTRL+SHIFT+S Applications

CTRL+SHIFT+D Dashboard

CTRL+SHIFT+O Profile

CTRL+SHIFT+F Preferences > Filters

Management CTRL+SHIFT+I Overview > Instances

CTRL+SHIFT+A Overview > Applications

CTRL+SHIFT+R Reports > My Reports

CTRL+SHIFT+N Instance Manager > Instances

CTRL+SHIFT+K Instance Manager > Tasks

CTRL+SHIFT+W Instance Manager > Worksteps

CTRL+SHIFT+C Balanced Scorecard > Console

Administration CTRL+SHIFT+V System > Log Viewer

CTRL+SHIFT+U User Management > Users

CTRL+SHIFT+G User Management > Groups

CTRL+SHIFT+Q User Management > Queues

CTRL+SHIFT+P User Management > Permissions

CTRL+SHIFT+E User Management > Delegate Settings

CTRL+SHIFT+L Applications > BizLogic

CTRL+SHIFT+Z Applications > BizSolo
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As a typical ITPC User, you will have access only to the Home module. Other modules to which you may 
have access are displayed along with Home, as additional tabs depending on your user type and user 
permissions.

You can customize these shortcuts by adding a new one or changing an existing one as per your requirement. 
For more details, see the Customization Guide.

Using Filter Bars

A filter allows you to reduce clutter and focus on the relevant data by displaying only selected data in the 
workspace. 

Use the Filter bar (see following figure) to apply a filter. Specify values by selecting them from the lists and/
or entering them in the text boxes, and then click Go. The combination of these values forms a filter. 

Figure 9   Filter Bar 

Global Filters

ITPC now provides global filters for most common filtering conditions. They are:

•   Overdue Tasks

•   Tasks Due Today

•   Tasks Due This Week

•   Tasks Due This Month

•   Tasks Due This Quarter

•   Tasks Due This Year

•   Critical Priority Tasks

•   High Priority Tasks

You can select a global filter as your default filter from the Home > Profile menu. Alternately, you can use 
it as required. 

Sorting a Column

If a column header is underlined, you can click it to sort the listed items on that column header. A downward 
pointing triangle beside the column header indicates that items are sorted in descending order. To sort them 
in ascending order, click the column header again. 
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Figure 10   Column Sorting

Navigating Through the List

The paging controls allow you to navigate through pages of the current list. These controls are located 
immediately above and below the list.

Figure 11   Paging Control

The number of items to be displayed per page is specified by the ITPC Administrator in the Administration 
module. For more details, refer to the “Using the ITPC Configuration Interface” section of the BPM Portal 
Administrator’s Guide. If the total number of items cannot be displayed in a page, then the exceeded items 
are displayed on the subsequent pages. 

If the number of pages are 10 or less, then all page numbers up to the last page are displayed below the list. 
You can click a page number to display the corresponding page. If the number of pages is more than 10, then 
click Next> to access the set of next 10 pages. Similarly, you can click <Previous to access the set of 
previous 10 pages. The total at the far right of the paging controls represents the total number of items in the 
list across all pages.

Drilling Down

If more information is available about an item in the list, then such an item is displayed with a hyperlink. 
You can click the hyperlink to drill down to the next level of data and view details of that item. 

Figure 12   Drilling Down 
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Selecting Rows

You can select one or more rows of items from the list of items displayed on the current page by clicking 
their respective check boxes in the first column. To select all rows in the current page, select the check box 
in the header row. Selection of rows is indicated by changing color of selected rows. 

Figure 13   Rows 

To clear a particular row, click its check box again. If you select the check box in the header row and then 
clear a check box of a row; then the check box in the header row is cleared.

Printing

The Print icon ( ) displays the contents of the current page in a printable format. You can use your 
browser’s print feature to print it.

Finding ITPC Details
To quickly find out the application server, database type and its version, ITPC version and its build number 
you are using, click About from the global links. It displays all these details in a pop-up window. You will 
need this information while contacting the ITPC support team. 

Getting Support
If you do not find the solution to your problem in the product documentation, then you can contact the 
support team. Click Support from the global links (or on the BPM Portal Login page) to launch your default 
mail tool to send a mail to the support team. 

Accessing Help
You can access online help by clicking Help from the global links. The help is launched in a separate 
browser window. BPM Portal provides context-sensitive help, displaying the help topic that is relevant to the 
current module.

Logging Out
To quit BPM Portal, click Logout on the global links. After a successful logout, BPM Portal automatically 
displays the BPM Portal Login page.
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Chapter 3

Basic Operations

This chapter explains the basic operations you perform while using BPM Portal. You can perform some or 
all of these operations in various BPM Portal screens. However, all these operations may not be available in 
each BPM Portal screen. 

Specifying a Date
You can enter a date (and time) in the various text boxes involving a Date (for example, Due Date, Start 
Date, End Date) by directly typing it. Alternatively, you can click the Select Date icon (  ), which is 
generally located next to a Date box, to specify a date, as shown in the following steps:

1.   Click the Select Date icon (  ) beside the Date box. For a blank Date box, the Select Date 
window displays the current month’s calendar and by default, highlights today’s date and the 
current time. 

Figure 14   Specifying a Date 

2.   To select a date from the displayed month, click the desired date. The selected date and time is 
displayed in the Date box.

To select today’s date, click Today.
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3.   To display the calendar for another month, use the single arrows provided above the days of the 
week. Click the arrow pointing right for the next month, or the arrow pointing left for the previous 
month. Alternatively, to select any other month, you can click and hold the mouse on either of the 
arrows and then drag it to the desired month.

4.   Similarly, to display the calendar for another year, click the double-arrow pointing right for the next 
year, or the double-arrow pointing left for the previous year. Alternatively, to select any other year, 
you can click and hold the mouse on either of the double-arrows and then drag it to the desired year.

5.   To change the default time, click the hour and minute boxes in the Time section, to increment the 
value by 1 unit. Alternatively, to decrement the value, hold down SHIFT and then click the 
respective boxes. To change the value by multiple units, point to the respective boxes and then drag 
to the right to increment or to the left to decrement the value.

If the ITPC Administrator has set a 12-hour clock, then click AM or PM to switch betweeen these 
values.

Note:    By default, the Select Date window displays the calendar with each week starting Sunday. To 
change this setting to another day of the week, click the day in the calendar header.

Searching Users
You can enter a user name in the various text boxes involving Users (for example, User Name, Reassign, 
Delegated to) by directly typing it. Alternatively, you can click the Search User icon (  ), which is 
generally located next to a User text box, to search for a user, by performing the following procedures:

1.   Type a user name in the User Name text box. When the Search User icon (  ) is displayed 
beside the text box, click on it to open the Search Users page, where you can search for the users. 
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Figure 15   Searching Users 

2.   You can also search for the users by specifying either the user name, or the first name or the last 
name. If you specify the group name, it will search for the users in that group, otherwise it will 
search in all groups. 

3.   After typing the user name, first name, last name, and optionally, group, click Go. You can also use 
the * as a wild card. Type in the first letter and then the asterisk (example, a*) and all users 
beginning with that letter will display. It also works for portions of names; e.g., type in *son and all 
names ending in son (Jackson, Peterson, etc.) will be displayed. Type Mc*son and users such as 
McPherson and Mcwilliamson will be displayed. 

BPM Portal lists all the users satisfying your search criteria. You can navigate through this list as 
explained in the Navigating Through the List on page 24. 

4.   To go directly to the list of users starting with a particular letter, click that letter in the Quick Search 
bar. 

5.   Depending on the page and current operation, BPM Portal allows you to select one or more users. 
Select users by clicking the options in the first column of those users, and then click Add. The 
selected users’ user names are entered in the User Name text box.

Note:    Depending on the page and current operation, the Add & Continue button may also be available. 
Click this button to add the current user and continue adding more users.

Searching for a group is similar to searching for a user. While searching for a group, you need to specify the 
group name in the Group Name box by directly typing it. Alternatively, use the Search Bar to locate the 
specific group by performing a procedure similar to the one explained above for searching the users.
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Working with Attachments 
BPM Portal enables you to attach, update, and remove documents associated with entities such as tasks. For 
instance, you can use this feature to circulate a resume as a part of a hiring review process, or to circulate one 
or more functional specifications associated with a design approval process. 

Note:    The ability to attach documents is not part of every task—the application must be designed to 
enable this feature. 

The ITPC administrator at your organization can configure your system to use either the JavaScript or Java 
applet interface styles for the document attachment feature. This section describes both user interface styles. 
Java applet is the default interface. 

Your ability to attach, update, and remove documents depends on the type of workstep that stores the 
document. The possible cases are summarized in the following table:

Whether an attached document will be in read-only or read/write mode, depends upon the settings specified 
while defining the document dataslot. For more information, see the “About Document Dataslots” section of 
the Application Developer’s Guide.

You may attach any kind of file (.doc, .xls, .pdf, .gif, .html) as long as the file is located in your computer. 
When you open an attachment, the BPM Portal lets the browser identify the associated application.

Note:    The default setting for document attachment size is 5 MB. Contact your system administrator if 
you want to increase this size to attach larger documents.

Using the Java Applet Interface

The examples shown here are demonstrated with BPM Portal with Java Applet Interface.

Attaching a Document

You may attach a document using the Java applet interface, either while starting an application (from the 
ITPC Application page) or while completing a task (from the Task Details page). 

1.   Click the File(s) button in the Document field as shown in Figure 16.

BPM Portal displays a pop-up menu with available document options.

Table 7   Attachment Update Options

If the attachment is... You can...
Read-only View attached documents, but you cannot attach new documents, nor 

can you delete or update existing attached documents. You can, 
however, save a copy on your computer.

Read/write Attach, remove, and update documents.
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Figure 16   Attaching a Document Using the Java Applet Interface

2.   Choose Add File(s) from the pop-up menu.

BPM Portal displays the Attach Document window, enabling you to move through drives and 
folders. 

3.   Select a file and then, click Open.

BPM Portal adds the file to the pop-up menu, as illustrated in Figure 17.

Figure 17   Attached Files Appear on the Pop-up Menu

4.   You can attach additional documents if the task allows for multiple attachments. 

See the BPM Studio User’s Guide for more information on attaching multiple documents.

Click to find file to attach

Name of attached file
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NOTE:    Documents attached are uploaded at the time the task is created, completed or saved.

Updating Documents

You can update a document attached to a task from the Task Details page. To do so, follow these steps:

1.   Click the File(s) button.

BPM Portal displays a pop-up menu of attached documents.

2.   Select and open the document to update from the pop-up menu.

3.   Modify the document and save your changes.

BPM Portal automatically uploads the updated document to the BPM Portal server when the task is 
saved or completed. It is not necessary to manually reattach the document. However, you must save 
your updated document (Word, Excel, etc.) in order to access it from the pop-up menu.

NOTE:    A document is uploaded to your system only when the task is created, saved or completed. 
Accessing the document from the pop-up before saving the updates yields the original 
attached document, not your updated document.
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Removing Attached Documents

You can remove a document attached to a task from the Application Details page. To do so, follow these 
steps:

1.   Click the File(s) button.

BPM Portal displays a pop-up menu of attached documents.

2.   Select the document you wish to remove.

3.   From the submenu, choose Remove and then select Yes to the confirmation question as shown in 
the following figure. BPM Portal removes the selected document.

Figure 18   Removing Attached Documents

Updating Documents Accessed by Multiple Users

BPM Portal allows multiple users to concurrently update the contents of their attached documents with or 
without other users seeing their modifications or edits. The ability to see other users’ document 
modifications depends on one of two types of document attachments. These are as follows:

•   Unprotected. Allows a document that is updated and reattached by one user to be viewed, updated 
or removed by another user who is completing the same task.

•   Protected. Allows users to update and reattach documents without other users viewing their 
modifications.

Note:    When you create a Document dataslot in BPM Studio, you can set the Editable by Author Only 
check box to prevent other users who also receive the attachment from either seeing or altering 
the changes you made to the document. When a user reattaches his/her updated document, the 
user's name appears in front of the file name (for example, robin_filename.doc). Refer to the BPM 
Studio User’s Guide for more information on document attachment user capabilities. 

All changes to the document attachment will become visible only when the document is unprotected.

Select Yes to remove file
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An ITPC user can send a confidential document to multiple ITPC users by attaching it to a task as a 
protected document. Each of these recipient ITPC users will receive that task in their respective Task List 
page. 

Each of them can individually access that task, open the document, make necessary changes and save it in 
their local directory. They can then attach the modified document to the same task and mark that task 
completed. At any time, none of the recipient ITPC users can see other users’ document even though they 
will be accessing the same task and same copy of the document attached to it. 

When all the recipient ITPC users complete their respective tasks, a new task is added in the originator’s 
Task List page. This task has all the recipient ITPC users’ modified documents as attachments. To help the 
originator identify the sender of the document, BPM Portal automatically prefixes the user name of the 
sender and an underscore, to each modified file name (for example, robin_filename.doc).

With this feature, BPM Portal provides you collaboration without compromising the confidentiality.

Using the JavaScript Interface

The examples shown here demonstrate BPM Portal with JavaScript interface.

Attaching a Document

You may attach a document using the JavaScript interface, either while starting an application (from the 
ITPC Application page) or while completing a task (from the Task Details page). 
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1.   Click the File(s) button in the Attach Document field, as shown in the following figure.

Figure 19   Creating a Task that Supports Document Upload

BPM Portal displays a window enabling you to select and attach the document from the local or 
network directory.

2.   Click Browse to select the file to attach. Select a file and click Open in the Choose file window. 
The path of the selected file is displayed in the Find File text box. You can click Reset to clear this 
path. Note that, when you click Reset, only the path of the last selected file is removed from the 
Find File text box. Any previously attached files are not removed. You have to remove them 
explicitly. For more information, see Removing Attached Documents on page 35.

3.   Click Add to attach the document.

The file is added in the Existing Document(s) table in the window, as illustrated in Figure 19. 

4.   You can attach additional documents if the task allows for multiple attachments. Otherwise, you can 
attach only a single document. 

See the BPM Studio User’s Guide for more information on attaching multiple documents.

5.   Click Close.

BPM Portal navigates back to the previous page. 

Note:    Documents attached using JavaScript are uploaded to the BPM Portal server immediately.

2–Click to find file

1–Click to open window

4–Click Done after file is attached

3–Click to attach
file
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Updating Documents

You can update a document attached to a task from the Task Details page. To do so, follow these steps:

1.   Click File(s). BPM Portal displays a window showing the list of attachments, as illustrated in the 
following figure.

Figure 20   Attached Documents

2.   Click a document to update it.

If the document is read/write, you must save the document to your local file system and reopen the 
file in order to modify or edit it. Your changes are reflected in your saved document and not in the 
original BPM Portal document attachment. If the attachment is read/write, you must reattach your 
modified and saved document to the task in order to pass your changes along in BPM Portal. The 
Delete icon is displayed only for the document with read/write attachment option.

If your attachment is read-only, you will not be able to reattach the document to the task if you 
modify it. 

Removing Attached Documents

To remove attached documents from a task, complete the following steps:

1.   Click File(s).

BPM Portal displays the attachment window, as illustrated in Figure 20.

2.   Click Delete button next to the document to remove it.

BPM Portal removes the document from the list.

NOTE:    You cannot delete an attached file from a task if the attachment option is read-only. An 
example is shown in the following figure. See Table 7 for more details.

Figure 21   Read-only Documents Window

Updating Documents Accessed by Multiple Users

You may also use the JavaScript interface, which allows multiple users to concurrently modify the contents 
of their attached documents with or without others seeing the modifications. The basic principles of 
updating documents accessed by multiple users, using the JavaScript interface are same as that of using the 
Java Applet interface. For more details, see Updating Documents Accessed by Multiple Users on page 32.
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Chapter 4

Introducing the 
Management Module

This chapter describes the new features introduced in EMC IT Process Centre (ITPC) 2.1, introduces you to 
the Management module of BPM Portal, and presents an overview of the Management user interface.

Before logging into the Management module, accomplish the following things:

•   Adjusting Your Browser Cache Setting.

•   Customizing the Date Format for Display (optional).

You can then:

•   Open the Management module by Logging into the Management Module.

•   Learn about controlling access to Management features by Reviewing User Access/Permissions.

What’s New
ITPC provides the following new features in the Management module:

•   Heatmap

•   Creating reports using JasperReports

•   Wizard-like interface for Balanced Scorecard Designer
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•   Easy access to Chart View

•   Dashboard Improvements

•   Report Versioning

•   Application Overview Status List

•   PSV Display Improvement

•   Tabular View column

•   Estimated Duration vs. Elapsed Time Report, a new Out-of-Box report

•   Support to show all instances with sub-processes in a report

•   Improved BizSQL Report output

•   BPM Portal Report column header sorting

Adjusting Your Browser Cache Setting
To ensure that you are always viewing up-to-date information, you can set the cache parameter for your 
browser to check newer versions of stored pages every time you visit by navigating to the settings using the 
paths shown in the following table:

You also need to install the Sun JDK version 1.3 or later, and set it as the virtual machine of your browser. 
For more details about downloading and installing it, refer to Sun Microsystems’ site and documentation.

Customizing the Date Format for Display
The Management module uses the Java class SimpleDateFormat to display times and dates, which you can 
configure using the DateFormat parameter in the bpmportal.properties file in your 
%AppServer%\sbm\WEB-INF\classes\properties directory (There may also be property files for each 
available language—e.g., bpmportal_en.properties for English, bpmportal_ja.properties for Japanese in this 
directory). Under this system, use a time pattern string to specify the specific time and date format for your 
date format (in bpmportal.properties) or for a specific language (e.g., to change a date format only for 

Table 8   Browser Cache Settings

For this browser... Navigate to...
Internet Explorer Tools > Internet Options > open the General tab > Temporary 

Internet Files > Settings, where you can select one of four options.

Netscape Navigator Edit > Preferences > expand the Advanced heading > Cache, where 
you can select one of three options.
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Japanese, open the bpmportal_ja.properties). Additionally, you need to make the same changes in the 
bpmportal.properties and the property file for each available language in the 
%ITPC_HOME%\conf\properties directory. ASCII letters are reserved as pattern specifiers in the 
SimpleDateFormat pattern, and the symbols are defined in the following table:

Note:    As indicated in Table 9, DateFormat is case-sensitive.

Refer to the following rules when using time and date formats:

•   The number of pattern letters determines the format, according to the following:

– (Text): If there are four or more pattern letters, use the full form. If there are less than four 
pattern letters, use the short or abbreviated form, if one exists.

– (Number): The minimum number of digits. Shorter numbers are zero-padded to this 
amount. Year, however, is handled specially—if the count of ‘y’ is two, the Year will be 
truncated to two digits.

– (Text & Number): Three or over, use text, otherwise use number.

•   Characters in the pattern that are not in the ranges of [‘a’..‘z’] and [‘A’..‘Z’] are treated as quoted 
text. For instance, characters such as ‘:’, ‘.’, ‘ ‘, ‘#’ and ‘@’ appear in the resulting time text even 
though they are not specified within single quotes.

•   A pattern containing an invalid pattern letter results in a thrown exception except during formatting.

Table 9   SimpleDateFormat Time Pattern Strings

Symbol Meaning Presentation Example
G era designator Text AD

y year Number 1996

M month in year Text & Number July & 07

d day in month Number 10

h hour in am/pm (1~12) Number 12

H hour in day (0~23) Number 0

m minute in hour Number 30

s second in minute Number 55

S millisecond Number 978

E day in week Text Tuesday

D day in year Number 189

F day of week in month Number 2 (2nd Wed in July)

w week in year Number 27

W week in month Number 2

a am/pm marker Text PM

k hour in day (1~24) Number 24

K hour in am/pm (0~11) Number 0

z time zone Text Pacific Standard Time

‘ escape for text Delimiter

‘‘ single quote Literal ‘
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The default date format setting for ITPC applications is MM/dd/yyyy, which displays a date of February 
18, 2006 as 02/18/2006. The following table presents examples of the date format pattern using U.S. locales:

Logging into the Management Module
You can log into the Management module through the BPM Portal, the single sign-on portal for ITPC. You 
need to log in only once to gain access to any other ITPC modules for which you have been granted 
permissions. These modules can include Management, Home and Administration.

Note:    If you are using Internet Explorer 6.0 SP1, make sure that you have the Microsoft Virtual Machine 
installed. To verify this, select Tools > Internet Options, and open the Advanced tab. Under the 
“Microsoft VM” heading, make sure the “JIT compiler for virtual machine enabled (requires 
restart)” check box is selected. 

After starting the servers, you can log into BPM Portal. For more details, see Logging In on page 17 . 

Click the Management tab to access the Management module. ITPC automatically authenticates your user 
name and password and displays the Instances Overview page.

Note:    ITPC’s Access Control Management feature displays an error message if you were not granted 
permission to use this resource.

Table 10   Format Pattern Examples for U.S. Locales

Format Pattern Result
“MM/dd/yyyy (ITPC default) 07/10/2006

“yyyy.MM.dd G ‘at’ hh:mm:ss z” 2006.07.10 AD at 15:08:56 PDT

“EEE, MMM d, ‘yy” Mon, July 10, ‘06

“h:mm a” 12:08 PM

“hh ‘o’’clock’ a, zzzz” 12 o’clock PM, Pacific Daylight Time

“K:mm a, z” 0:00 PM, PST

“yyyyy.MMMMM.dd GGG hh:mm aaa” 2006.July.10 AD 12:08 PM
BPM Portal Manager’s Guide 39 Logging into the Management Module



To access features in the Management module, use appropriate module menus. This module contains the 
following menus:

•   Overview. Provides an overview of all active processes, as shown in Using Management Overview 
Features on page 44 .

•   Dashboard. Provides a visual representation of the progress and status of application processes. For 
more information, see Using the Management Dashboard on page 62 .

•   Reports. Displays available reports and provides the interface to define and create reports. For more 
information, see Executing and Creating Reports on page 66 .

•   Instance Manager. Allows you to efficiently manage large numbers of process instances, worksteps 
and tasks, and to perform tasks in batches rather than singly. For more information, see Using the 
Instance Manager on page 100 .

•   Balanced Scorecard. A performance measurement system that enables you to determine how your 
organization’s business activities are helping it meet its strategic goals. For more information, see 
Using the Balanced Scorecard on page 113 .

•   Infopad Manager. Enables you to update the information provided in an infopad, a table that stores 
such global data as application parameters or rule parameters. For more information, see Using the 
Infopad Manager on page 126 .

To access other ITPC modules that are available to you, click a module tab to display a range of menus 
under that tab. Open a menu and select a submenu item to open the feature. 

Once you log in to the BPM Portal, no further authentication is required when you open a new module.

Using the BizManage API
The BizManage API, a public API that provides Management module users with access to data that was 
previously internal, facilitates the customization of Management features. ITPC application developers and 
customizers no longer need to resort to workarounds and reverse-engineering to create the customized pages 
that they require – the BizManage API now exposes the elements needed to modify the Management module 
to users’ specifications.

The BizManage API also uses HTML templates for each type of element, allowing for different levels of 
customization within the interface pages for each building block. The API can access the lowest-level types 
of data available and utilized by the Management module, which prevents one of the primary causes for the 
workarounds that were necessary for customization in the past. While recognizing the need for low-level 
support, the BizManage API also offers higher-level support that includes packaged data and more complex 
renderings.

Finally, the BizManage API provides a set of features that enables BPM Portal modules to share a single 
login command.
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Accessing the BizManage API

The BizManage API is implemented as a bean, enabling the user to easily access the API from within all 
necessary types of applications. 

To simplify code and make customization easier, the Management module provides elemental data, i.e., 
commonly used data that generally is formatted for use within JSPs and/or for display within servlets. 

For more detailed information on the BizManage API, see the API Reference Guide.

Reviewing User Access/Permissions
The Access Control Manager (ACManager) provides more comprehensive and finer-grained security for 
ITPC users. During application development, the ITPC Administrator can determine the access a ITPC 
Manager has to a specific application and what permissions the user has: e.g., can the ITPC Manager access 
a specific process instance; or can the Management module user perform any action on a BizSQL report; or 
is the user denied permission to perform any action on the Dashboard. Although the results of this 
ACManager feature is seen in the Management module, it is defined by ITPC Administrators through the 
Administration module. If, as a ITPC Manager, you want to allow or prohibit certain users access to specific 
applications and/or grant or revoke specific permissions to a user, contact your ITPC Administrator. See the 
BPM Portal Administrator’s Guide for additional information.

Process-Level Permissions

To better understand how ACManager access/permissions work with Management features, consider the 
following points involving permissions for process templates, process instances and process dataslots:

•   To view and/or update a process template, a ITPC Administrator must assign you the corresponding 
rights. The view action enables you to see the item; the update action enables you to revise it. If you 
have not been assigned view and/or update permissions for a process template, it will not appear in 
the Management module.

•   To view and/or update a specific process instance, a ITPC Administrator must assign you the 
corresponding rights. You can also be assigned view/update permissions for all process instances.

•   To view and/or update a specific process dataslot, a ITPC Administrator must assign you the 
corresponding rights. You can also be assigned view/update permissions for all process dataslots. 

To view/update a process dataslot, you must be granted the associated permissions; i.e., to access a 
process dataslot, you must have the process instance permission and the process template 
permission.
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Report Permissions

To view/execute existing Management reports:

1.   The ITPC Administrator must first grant you the permission for the application(s) from which the 
report is derived. 

2.   The ITPC Administrator must assign you the permission to perform any action on the specific 
report type. In ITPC, there are four types of reports: Single Application, MultiApps, External and 
Infopad Report. 

3.   Once you have the required permissions, the Go button in the Create New Report page is enabled 
and you can execute an existing report (see Running an Existing Report on page 81 ).

NOTE:    The report may be filtered, since any process instance or dataslot that the user does not 
have permissions for is not shown. 

4.   To create a report, you must have permission for the application(s) the report will be derived from 
and have the Create a Report permission for the application. Once these permissions are granted, 
the Query button in the Create New Report page is enabled and you can create a report (see 
Creating Application (Query) Reports on page 83 ).

5.   To delete a report, you need the permissions described in step 4, as well as the Remove a Report 
permission. With these permissions, the Remove button in the Create New Report page is enabled 
and you can delete a report (see Removing an Existing Report on page 95 ).

6.   To modify an existing report, you need the permissions described in step 4, as well as the Modify a 
Report permission. With these permissions, the Modify button in the Create New Report page is 
enabled and you can modify an existing report (see Modifying an Existing Report on page 94 ).

To hold ReportBuilder permissions, the ITPC Administrator must assign you the permission to perform any 
action on any ReportBuilder, as well as permissions for the application(s) from which the report is derived.

To view/update BizSQL reports, you must have the permissions required for External reports and an 
additional permission to execute a BizSQL report (for more information, see About External Reports on page 
81 ).

Permissions for Other Management Features
•   To obtain permissions for the Dashboard, the ITPC Administrator must assign you the permission 

for the specific application, then grant an Execute permission to perform an action on a Management 
Dashboard item. 

•   To hold permission to view and/or update Infopads, the ITPC Administrator must assign you the 
view and/or update permissions for a selected infopad.

Note:    Remember that you must verify that top-level permissions (e.g., to an application) have been 
assigned in order for lower-level permissions (e.g., updating a report or accessing the 
Dashboard) are working.
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Logging Out
To quit BPM Portal, click Logout on the global links. After a successful logout, BPM Portal automatically 
displays the BPM Portal Login page. 

Note:    Please remember that when any applications are installed in ITPC to which you have been 
granted permission as a Manager, you must log out, then log in again, to ensure that this 
permission is reflected in ITPC.
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Chapter 5

Using Management 
Overview Features

The Management module of the BPM Portal is organized into a series of Web pages utilizing applets to 
enable you to quickly and efficiently manage EMC IT Process Centre (ITPC) applications. This chapter 
describes procedures that enable you as a ITPC Manager to monitor and update ITPC applications and 
process instances by performing the following functions: 

•   Checking the Status of an Instance, by displaying all instances for all applications, or using the 
filtering functions to view the status of specific instances for a selected application. You can also 
dynamically update the worksteps and workitems of an instance, and print the current status of the 
instances. 

•   Updating Worksteps and Workitems, dynamically modifying an active or suspended workstep or 
workitem without leaving the Management module.

•   Checking the Status of an Application, by selecting an application and reviewing its status. You can 
also view and update its global dataslots, as well as modify and send workstep instructions to other 
users of the selected application.

Note:    See Chapter 4, Introducing the Management Module for an introduction to the Management 
interface. See Chapter 7, Executing and Creating Reports for detailed information about using the 
Reports function to define and execute reports.
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Instances Overview Page
To view the Instances Overview page, in the Management module, click Overview > Instances. This page 
indicates the status of the application instances, as shown in the following figure.

Figure 22   Instances Overview Page

The Instances Overview page displays information about the application instances you are currently using. 
By default, it displays all instances and the following information about each instance:

Table 11   Instance Overview Information

Column Description
Application A unique identifier for the application instance.

Instance The name of the process instance.

Status The status of the filtered instance. 

Creator The name of the user who created the instance.

Tabular Click the icon in this column to display the tabular view of the process instance.

Flow Click the icon in this column to display the process instance flowchart at the 
point of the active task.

Priority Priority level as determined by the user initiating the application. It can be Low, 
Medium, High, or Critical. 

Elapsed Time The time elapsed since the start time. 

Start Date The date the task was initiated. 

End Date The date the task was (or should be) completed, as determined by the 
application developer when setting the estimated duration in the Process 
Properties window.

Click a Flow icon to
open the Process 
Status Viewer and
see a flow chart for
the process instance.

Use the Filter bar
to search for

specific instances.

Instances that
meet the filter

criteria shown in
the workspace.
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In addition to the default columns, you can add dataslots as columns using the Dataslot Properties dialog box 
in the BPM Studio. For more information, see BPM Studio User’s Guide. These dataslot columns are 
sortable; that means, you can sort the contents of this page based on this column header. For more 
information, see Sorting a Column on page 23 . This helps to quickly locate instance(s) based on the 
application specific dataslot values.

Note:    Specify the date format for the reports using the DateFormat parameter in bpmportal.properties. 
See Customizing the Date Format for Display on page 37  for more information about the date 
format syntax. ITPC displays a warning message if you specify an invalid format for a Date field.

To manage the contents of the list, you can filter and/or sort them. To navigate through the pages, you can 
use the paging controls. For more details about these operations, see Exploring BPM Portal on page 21 .

The Instances Overview page enables you to:

•   Use the Filter bar to search through all applications, or a selected application, for specific process 
instances.

•   Check the status of the specified process instances.

•   Open the Tabular View to see the properties of each workstep displayed in a tabular format that 
presents data in a unified view.

•   Open the Flow View to see the process flow (i.e., the flow of work from one workstep to the next). 
From the Flow View, you can also see the instance’s information flow (i.e., the flow of data from 
one workstep to the next), as shown in the Dataslots View. You can also dynamically modify the 
process flow from the Flow View (for more information, see Editing Process Instances Using the 
Flow View on page 51 ).

Note:    This page is also the Management module’s default page, and the user can return to this page at 
any time by clicking the Management tab in the BPM Portal.

Checking the Status of an Instance 
To check the status of an instance, complete the following steps:

1.   In the Management module, click Overview > Instances, to view the Instances Overview page, as 
shown in the Figure 22.

2.   Use the search features in the Filter bar to specify the process instances you want to monitor. 

a. Select a ITPC application from the Applications drop-down list. Data on all instances for the 
selected application (or for all applications, if you choose All) are displayed in the workspace. 

b. Select an option from the Status drop-down list. Options include: All, Active, Completed, 
Removed or Suspended. Active indicates the instance is active and can be run. Suspended 
indicates the instance is temporarily stopped until the Resume option is selected.

c. Select an option from the Duration drop-down list. Options include: Hours, Weeks, Days, 
Business Days. You can use this search criteria only for instances with a Completed status.
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d. Specify a Creator, if applicable. If needed, you can click the adjacent icon to search and add 
users. For more details, see Searching Users on page 27 .

e. Select an option from the Priority drop-down list. Options include: All, Critical, High, 
Medium and Low.

f. Specify the period by selecting an option from the Date drop-down list. To define a more 
specific time range, select Custom from the Date drop-down list and then specify the dates in 
the From and To boxes. Alternatively, click the Select Date icon ( ) to set the respective 
from and/or to dates. For more details, see Specifying a Date on page 26 .

Note:    Specify the date format for the reports using the DateFormat parameter in bpmportal.properties. 
See Customizing the Date Format for Display on page 37  for more information about the date 
format syntax. ITPC displays a warning message if you specify an invalid format for a Date field.

3.   After you have finished entering filtering criteria, click Go to locate the specified instance(s).

ITPC displays all the instances satisfying your filter criteria, in the workspace.

Viewing Process Status
Click the Management tab to access the Management module. Click the Overview menu and select 
Instances to view the Instances Overview page. 

The Instances Overview page enables you to:

•   Use the Filter bar to search through all applications, or a selected application, for specific process 
instances.

•   Check the status of the specified process instances.

•   Open the Tabular View to see the properties of each workstep displayed in a tabular format that 
presents data in a unified view.

•   Open the Flow View to see the process flow (i.e., the flow of work from one workstep to the next).

•   From the Tabular View and Flow View, you can also see the instance’s information flow (i.e., the 
flow of data from one workstep to the next, as shown in the Dataslots View).

Note:    This page is also the Management module’s default page, and the user can return to this page at 
any time by clicking the Management tab in the BPM Portal.

To check the status of an instance, complete the following steps:

1.   In the Management module, click Overview > Instances, to view the Instances Overview page, as 
shown in the Figure 22.

2.   Use the search features in the Filter bar to specify the process instances you want to monitor. 

a. Select a ITPC application from the Applications drop-down list in the upper left of the Filter 
bar. Data on all instances for the selected application (or for all applications, if you choose All) 
are displayed in the workspace, as shown in the following figure. 
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b. Select an option from the Status drop-down list. Options include: All, Active, Completed, 
Removed or Suspended. Active indicates the instance is active and can be run. Suspended 
indicates the instance is temporarily stopped until the Resume option is selected.

c. Select an option from the Duration drop-down list. Options include: Hours, Weeks, Days, 
Business Days. Use this search criteria only for instances with a Completed status.

d. Specify a Creator, if applicable. Click the Edit Creator icon ( ) to open the User List, from 
which you can select a valid ITPC user. 

e. Select an option from the Priority drop-down list. Options include: All, Critical, High, 
Medium and Low.

f. Select an option from the Date drop-down list. Options include: Today | Yesterday, This Week 
| Last Week, This Month | Last Month, et al. To define a more specific time range, click the 
Select Date icon ( ) and choose a start date and end date from the pop-up calendars. 

3.   After you have finished entering filtering criteria, click Go to locate the specified instance(s).

The filtered instances appear in the workspace. The columns include: 

• Application: A unique identifier for the application instance

• Instance: The name of the process instance.

• Status: The status of the filtered instance. 

• Creator: The name of the user who created the instance.

• Tabular:Click the Tabular icon ( ) to display the tabular view of the process instance. 

• Flow: Click the Flow icon ( ) to display the process instance flowchart at the point of the 
active task (see Table 12 for color coding).

• Priority: The priority level as determined by the user initiating the process instance.

• Elapsed Time: The time elapsed since the start time. 

• Start Date: The date the task was initiated.

• End Date: The date the task was (or should be) completed, as determined by the application 
developer when setting the estimated duration in the Process Properties dialog box.

Note:    Specify the date format for the reports using the DateFormat parameter in bpmportal.properties. 
See Customizing the Date Format for Display on page 37  for more information about the date 
format syntax. ITPC displays a warning message if you specify an invalid format for a Date field.
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4.   Click the Tabular icon in the Tabular column to view the properties of each workstep displayed in 
a tabular format that presents data in a unified view. 

The Tabular View displays the Start workstep as the first workstep at the top of the list. It is 
followed by the remaining worksteps in alphabetical order and the End workstep is displayed as the 
last workstep. The same color coding described in Table 12 is also used in the Tabular View.

Figure 23   Tabular View

When you are in the Tabular View, you can:

•   Update an Active workstep by modifying its Priority or by changing its Action; e.g., suspending 
an active workstep.

•   Update a workitem by changing the Performer or selecting an Action.

•   Send an e-mail to the performer(s) by clicking the Performer link. ITPC launches your default 
mail client and enters the e-mail addresses of the performer(s). If there are multiple performers 
comprising any combination of, list of users and list of groups, then ITPC enters individual 
e-mail addresses of those users and group members. However, if a group contains users and 
another group, then ITPC enters e-mail addresses of only the users but does not enter e-mail 
addresses of the nested group's members.

5.   Click the Flow icon ( ) in the Flow column to open the Flow View, where you can view the 
instance in a flowchart, as shown in the Figure 24 on page 50. The worksteps color coding is 
explained in Table 12. 
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Figure 24   Flow View 

Note:    If you want to display the Flow View without any BPM Studio features, you need to add 
bpmportal.pieditor.override parameter in the bpmportal.conf file, and set its value as 
TRUE.

Table 12   Workstep Color Coding

Workstep Color... Indicates...
Yellow Active workstep

Gray Inactive (i.e., unperformed) workstep

Green Completed workstep

Orange Suspended workstep

Links to
Tabular View

and
View Dataslots
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6.   To access dataslot information for the process instance from the Tabular or Flow View, click View 
Dataslots to open the View Dataslots page, as shown in the figure below. This page appears if 
you have been granted Dataslot permissions.

Figure 25   View Dataslots Page

If you have only View permission for the Dataslot resource, the fields in the View Dataslots page 
are read-only. If you have View and Update permissions for the Dataslot resource, the fields are 
editable, as shown above.

To change the dataslot information for the process instance:

a. Modify the priority of the instance by selecting an option in the Priority drop-down list.

b. Modify the status of the instance by selecting from the options in the Status drop-down list. 

Note:    Only Active application instances can be modified. However, you can attach documents to a 
Suspended application instance. 

c. Modify the remaining dataslots as needed, and click Save at the bottom of the form. ITPC 
updates the dataslots after your confirmation. 
To reset the form and remove the information you just entered, click Reset. To cancel the 
action and exit the current page, click Cancel.

Editing Process Instances Using the Flow View

The Flow View enables users to dynamically modify the workflow of a selected process instance. Before 
using the dynamic workflow feature of Flow View, make sure that the selected process instance is in an 
Active state and that none of the worksteps are in a Suspended state. Also, all worksteps assigned an Active 
status in the process instance must be human-performed worksteps. 

When implementing dynamic workflow, the BPM Portal obtains the process template information through 
the process instance SVO—you cannot directly access the dynamic process template/workstep template 
SVO. Upon completion of modifying the dynamic process instance, the process template is removed if the 
removeOnCompletion is “true” during the creation of a dynamic process template.
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The Flow View is a scaled down version of the BPM Studio. You can perform many BPM Studio operations 
in this mode such as adding worksteps, modifying workstep properties, viewing dataslots, and changing 
performers. However, before you attempt editing the current instance, note that:

•   The selected process instance must be Active and that none of the worksteps should be in the 
Suspended state. 

•   All Active worksteps in the process instance must be human-performed worksteps. 

•   The edited process instance can run concurrently with the original process instance, or the original 
process instance can remain Suspended.

This Flow View is composed of:

•   A Toolbar containing icons for the Select and Connect tools. 

•   A Task pane (or sidebar) that, by default, lists Shapes; that is, the worksteps and other process 
instance elements that comprise the structure of the process instance displayed in the workspace. 

•   The workspace, used to edit your process instance diagram, and workspace tabs that include the:

• Diagram tab. The default page where you edit process instance diagrams, as shown in the 
following figure.

• Dataslots tab. Contains all the dataslots defined for the selected application. Click this tab to 
display the Dataslots page. You can view all dataslots available for the selected process 
instance on this page.

• Performers tab. Contains a list of all the performers used in the process instance. 

This Flow View allows you to edit a process instance directly from your browser, and is very similar to the 
BPM Studio. However, unlike BPM Studio, which is used to create and/or edit process templates, this Flow 
View can be used to edit process instances only. For more information, see BPM Studio User’s Guide.

From the Flow View, you can:

•   Modify the properties of any Inactive workstep by double-clicking it.

•   Add a workstep to the process instance.

•   Remove an Inactive workstep.

•   Drag and drop existing predefined adapters that are present in the Performers list, or that have been 
created elsewhere and added to the Performers list.

•   Provide support for Swim Lanes for Performers, after the swim lanes were added in the BPM Studio.
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Note that while you are editing the current process instance, you are not allowed to:

•   Remove worksteps that are in Active, Suspended or Completed state.

•   Add or delete dataslots.

•   Modify dataslot metadata and values.

•   Add or delete performers.

•   Define new adapters or a subprocess.

•   Drag and drop Managed Adapters from the task pane.

•   Add Rollback to an activity.

•   Specify header and footer for a workstep.

•   Modify properties for an Active or Completed workstep.

•   Save any modifications if the process instance is Suspended or has a Suspended workstep.

•   Use versioning with dynamic process instances.

•   Connect to a server and retrieve the list of processes already installed.

•   Connect to WSDL and select the method for a new Web Service.

•   Complete tasks by email. When the dynamic process instance is dynamically created, the performers 
of the activated human-performed tasks are not notified about their tasks.

Note:    You can modify any process instance only once. If further modification is attempted, a warning 
message is displayed.

Note:    If you want to display the Flow View without any BPM Studio features, you need to add 
bpmportal.pieditor.override parameter in the bpmportal.conf file, and set its value as 
TRUE.

Updating Worksteps and Workitems

You can dynamically update worksteps and workitems in the Management module by performing the 
following procedures.

1.   From the Flow View page, click any completed (green), active (yellow) or suspended (orange) 
workstep from the flowchart to open the Workstep Details window.
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2.   The Workstep Details window for a completed workstep (see figure below) displays read-only 
data that cannot be modified. 

Figure 26   Workstep Details Window for a Completed Workstep 

Active or suspended worksteps display a dialog window with editable fields, where you can update 
certain workstep and workitem properties. The following figure presents the Workstep Details 
window for an active workstep. 

3.   To send an e-mail to the performer(s), click the Performer link. ITPC launches your default mail 
client and enters the e-mail addresses of the performer(s). If there are multiple performers 
comprising any combination of, list of users and list of groups, then ITPC enters individual e-mail 
addresses of those users and group members. However, if a group contains users and another group, 
then ITPC enters e-mail addresses of only the users but does not enter e-mail addresses of the 
nested group's members.

Figure 27   Workstep Details Window for an Active Workstep 

4.   To dynamically modify an active or suspended workstep or a workitem during run-time:
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a. In the Workstep Details section, select an option from the Priority drop-down list to update the 
workstep’s priority.

b. In the Workitem(s) section, update information about the Performer by entering data in the 
Performer box or by clicking  to open the User List page, where you can select a valid 
user from the list of ITPC users.

c. In the Workitem(s) section, update Action information by selecting an option from the 
drop-down list in the Action column.

d. If you want to suspend the workstep, click Suspend Workstep. The Suspend Workstep 
option changes the workstep color to orange, and temporarily stops the process at the 
suspended workstep until the issue causing the suspension is resolved or you resume workstep 
execution. 

e. If you want to complete the workstep, click Complete Workstep. The Complete Workstep 
option changes the workstep color to green. ITPC takes a while to mark the workstep as 
completed and change its color. Therefore, you may have to refresh the screen more than once 
to reflect the color change.

f. If the Completed workstep has been designated as a Rollback Point (i.e., it is the workstep 
from which the work flow will be restarted if the process fails during execution), a Rollback 
button is displayed in the Workstep Details window. Select Rollback to “roll back” the 
process to the rollback point. For more information on rollback, see “Using the Rollback 
Process” in the BPM Studio User’s Guide.

g. Click Save to save any changes you made in the Workstep Details page. ITPC automatically 
reloads the Flow View.

Click Cancel to delete any updates, and return to the Flow View page.

Note:    Completed worksteps and workitems cannot be modified. Removed instances also 
cannot be modified.

Printing the Flow View in the Process Status Viewer

In the Flow View page, click the Print icon ( ) in the top right corner of the screen (refer to Figure 24) to 
display a printable version of the Flow View. ITPC displays the Flow View in a separate, browser window. 
To print it, use the print command from the Web browser.

Note:    The printable Flow View is presented in the PNG graphic format. You cannot click on the 
worksteps in this window to modify the properties. To do so, return to the Flow View page.
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Checking the Status of an Application
To view the Application Overview page, in the Management module, click Overview > Applications. The 
Application Overview page enables you to:

•   Check the status of one or more selected applications.

•   See the process flow (i.e., the flow of work from one workstep to the next), as shown in the Flow 
View.

•   See the tabular view that displays each workstep and its instructions for a selected application in a 
tabular format, as shown in the Tabular View. 

•   See the information flow at the application level, by opening the Global Dataslots view.

•   Prepare or modify instructions or comments and send them to users of the process you are managing, 
by using the Application Information link. 

To check the status of an application, complete the following steps:

1.   In the Management module, click Overview > Applications. The Application Overview page is 
displayed as shown in the following figure. 

Figure 28   Application Overview Page

2.   Select a ITPC application and/or select a status from the Applications and Status drop-down list 
respectively, and click Go. The Application Overview page is displayed. This page displays 
information about the applications satisfying your filtering criteria. By default, it displays all 
applications and the following information about each one of them:

Table 13   Application Overview Information

Column Description
Application A unique identifier for the application instance.

Status The status of the filtered instance. 

Tabular Click the icon in this column to display the tabular view of the process instance.

Flow Click the icon in this column to display the process instance flowchart at the 
point of the active task.
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To navigate through the pages, you can use the paging controls. For more details about these 
operations, see Exploring BPM Portal on page 21 .

3.   Click the Tabular icon in the Tabular column to view each workstep for a selected application 
displayed in a tabular format. Here also, you can enter new, or modify existing, instructions for 
each workstep.

4.   Click the Flow icon in the Flow column to view a workflow chart of the selected application in the 
workspace.

5.   Click a workstep to open the Workstep Instructions window (see the following figure), where you 
can enter new, or modify existing, instructions for that workstep.

Figure 29   Workstep Instructions Window

6.   Click Save to save the instruction and go back to the previous page. 

To cancel the action and exit the current window, click Cancel.

7.   To change from the Tabular view, click the Flow View link to view the Flow View. Similarly, to 
change from the Flow view, click the Tabular View link to view each workstep for a selected 
application displayed in a tabular format. Here also, you can enter new, or modify existing, 
instructions for each workstep.

8.   Click Save to save any changes you made in the Workstep Instructions window or in the Tabular 
View page. Click Reset to clear any data you entered and return to the original settings.
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Using the Heatmap

When you click the Flow icon for a process in the Application Overview page, a color-coded Flow View or 
Heatmap is displayed as shown below.

Figure 30   Heatmap 

A heatmap helps a ITPC Manager to:

•   Get an overview of the status of the currently active instances. Using this as a tool a business 
manager can identify potential bottlenecks in the process.

•   Identify worksteps that have been suspended, for a variety of reasons and take necessary actions to 
resume the suspended processes.

•   Ananlyse the history of the completed instances to identify potential trends and opportunities for 
optimization.

In the Flow View, you can use the PI Status to filter the instances and Workstep Status drop-down lists to 
filter the worksteps in the heatmap based on their status. You can select Completed from the PI Status, click 
Go, and then Completed from the Workstep Status, or select Actived from the PI Status, click Go, and then 
select Activated, Suspended or Completed from the Workstep Status drop-down list. The heatmap 
graphically shows the status of all worksteps for the specified status of process instances. For example, if 
you select Activated from the PI Status drop-down list and Suspended from the Workstep Status drop-down 
list, then the heatmap displays all suspended worksteps of all the active process instances. When you change 
Workstep Status option, the heatmap is automatically refreshed. However, when you change the PI Status 
option, you need to click Go to refresh the heatmap.

Each workstep is color-coded as described in the following table. 

Table 14   Heatmap Color Coding

Color Range Description
Red to White For values between the maximum and the mediana.

a. Median is calculated by adding all the values for each activity and dividing this sum by the total
number of activities.

White to Blue For values between the median and the minimum.
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The number in the parenthesis after the activity label indicates the total number of workstep instances of the 
specified status.

A bottleneck can be identified by a red workstep immediately followed by one or more white worksteps, as 
shown in the following figure.

Figure 31   Heatmap of a Bottleneck 

Modifying Global Dataslots

Global dataslots are application-level dataslots that occur in each process instance of the application. In 
previous releases, dataslot values were limited to individual process instances.

To view and/or dynamically update dataslot information globally (i.e., at the application level), from the 
Management module: 
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1.   In the Management module, from the Application Overview page, click the application name to 
display Global Dataslots page; or click the Tabular or Flow icon and then click Global Dataslots 
to display the Global Dataslots page (see the figure below), displaying all the dataslots that occur 
across the application. 

Figure 32   Global Dataslots Page 

2.   Modify the information in the activated boxes as required.

3.   Click Save to save your changes. ITPC reloads the page and automatically updates the values across 
all process instances.

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current page, click Cancel.

Sending Information to Application Users

The Application Information feature in the Management module enables you to modify workstep 
instructions at a process template level and to send the modified instructions to other users of the application 
without having to modify the original process template, providing application users with the most up-to-date 
information. 

Use this feature to enter new, or modify existing, instructions for the application. Instances created after the 
change receive the new instructions, while old instances retain the original instructions.
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To use the Application Information feature:

1.   In the Management module, click Overview > Applications. The Application Overview page is 
displayed.

2.   Select an application from the Applications drop-down list, and information on that application is 
displayed in the workspace.

3.   Click the Application Information link. The Application Information page is displayed, as shown 
below. By default, three rows are displayed.

Figure 33   Application Information Page 

4.   Select a check box and enter instructions, comments or other details in the corresponding 
Information box.

5.   Enter the Web site address in the corresponding URL box.

6.   To add rows, click Add 3 Rows. A set of three rows are automatically added.

To delete one or more rows, select the check box for each row you want to remove and click 
Delete.

7.   Click Save to save the changes. ITPC saves the changes and after your confirmation, automatically 
sends the information to the specified URL address. 

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current page, click Cancel.

Note:    You can only use this feature to send information on Activity, Start, and End worksteps.
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Chapter 6

Using the Management 
Dashboard

This chapter explains you how to use the Dashboard feature of the Management module.

Management Dashboard
The Management Dashboard enables managers to display a graphic overview of the status of several 
business processes on a single Web page and to monitor the progress of these processes. The user can 
choose one of the following Management Dashboard views: 

•   The default Global view, which contains seven panes and is designed to give the user the entire 
picture of what is happening across all ITPC applications.

•   The Application view, which contains six panes and is designed to provide specific information 
about the selected application. 

The Management Dashboard page provides a set of widgets that display application data within one of the 
sections within a Global view or an Application view. The widgets dynamically execute associated or 
predefined queries for each section. You can specify various properties for these widgets by using their tags 
in the dashboard.jsp file. The <ChartSQL> element of this file specifies a query string that establishes data 
retrieval processes from the database for the widget, and the <ChartURL> element specifies the URL of 
the pre-defined report to be displayed when that widget is clicked. The widgets provide visual summaries 
that include the pie and bar charts, and the gauges, as shown in Figure 34 on page 63 and Figure 35 on page 
64. You can click any widget to view its details. For more information, see Viewing the Details of a Widget 
on page 65 .

Each time a new process with active instances is installed, ITPC enters the data in a default Dashboard 
Table, or updates the data in an existing Dashboard table after a delay which is configurable. This 
information is seen by ITPC Managers when they access the Management Dashboard. However, users must 
log out and log in again to see changes in a database reflected in the Management Dashboard. For example, 
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if the infopad count in one of the widgets increases to 9 in the database and its default range is 0-5, you must 
first increase the range of the widget in the dashboard.jsp file. To see the new infopad count of 9 reflected in 
the Management Dashboard, you must log out of the Management module and then log in again, to see the 
new value displayed in the Management Dashboard.

Customizing the Management Dashboard

Customizing the Management Dashboard and creating custom dashboard tables are the responsibilities of 
Application Developers, and involve modifying the dashboard.jsp file and a Java-based table populating 
mechanism. Custom console tables can be designed to collect application-specific information, which can 
then be viewed through the Management Dashboard. For more information on managing, populating and 
customizing data in the Management Dashboard, see the Customization Guide.

Accessing the Management Dashboard

To access the Management Dashboard:

1.   In the Management module, click Dashboard, to view the Management Dashboard page. 

Figure 34   Management Dashboard - Global View

2.   The Management Dashboard provides a Global View, which presents data for all active 
applications (see the figure above), and an Application View, which present data for a selected 
application (see Figure 35 on page 64). The Global View appears by default and contains the 
following widgets:

• Application Priorities, which displays, in a pie chart format, the overall ratio of Critical, 
High, Medium and Low priority instances for all applications.

• Application Status, which displays, in a pie chart format, the number of instances with an 
Active, Completed, Removed or Suspended status.

• Average Duration, which displays, in a guage format, the average time (in minutes) to 
complete an application.When there is no data for this widget, a black arrow indicates zero.
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• Infopad Count, which displays, in a gauge format, the number of infopads available in all 
applications.

• Active Applications, which displays, in a bar chart format, the applications that are active 
and the ratio of active instances for each application.

• Applications Due Today, which displays, in bar chart format, the number of instances for 
each application that is due on the current day.

• Overdue Applications, which displays, in bar chart format, the number of overdue 
instances for each application.

NOTE:    If you have many applications, then in the barchart widgets, like Active Applications, 
Applications Due Today and Overdue Applications, the parameters on the x-axis (for 
example, application names) may overlap, and therefore, may not be legible. You can 
overcome this problem by resizing these widgets by using the chartHeight and 
chartWidth attributes of the respective barchart tag from the dashboard.jsp file. For 
more details, see the Customization Guide. 
If you want to quickly find the names of few of these applications, then you can move the 
cursor on the corresponding bar, and the name of that application is displayed as a tooltip.

3.   To obtain views of the status of a specific application, select that application from the Application 
drop-down list and click Go. The Application View appears (see the following figure). 

Figure 35   Management Dashboard - Application View

The Application View contains the following widgets:

• Completed Applications displays, in a bar chart format, the number of Completed 
instances for the selected application.

• Average Application Duration displays, in a gauge format, the average time (shown by 
default in minutes) to complete an instance for the selected application.

• Application Priorities displays, in a pie chart format, the overall ratio of Critical, High, 
Medium and Low priorities for active worksteps for the selected application.

• Active Worksteps displays, in a bar chart format, the ratio of active worksteps that each 
user is performing for the selected application.

• Worksteps Due Today displays, in bar chart format, the number of worksteps due on the 
current day for each performer for the selected application.
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• Overdue Worksteps displays, in bar chart format, the number of overdue worksteps  for 
each performer for the selected application.

Note:    ITPC Application Developers can customize the information displayed and how it is presented in 
the Dashboard pages. For more information on customizing, see the Customization Guide.

Viewing the Details of a Widget

You can click any widget to drill down to the next level of data and view its details. When you click a 
widget, a different report is invoked. The following tables present the type of reports and tables invoked by 
each widget, when you click the ‘All’ link in the top right-hand corner of that widget. 

In the Global View, data for all active applications is displayed in the reports.

In the Application View, data for a selected application is displayed in the reports.

If you click a particular slice of the pie chart or a bar of the bar chart, then the same report with the details of 
the clicked slice or bar is displayed.

For more information about these reports, see Appendix A, Predefined Reports.

Table 15   For All Applications

Widget Page (Report Type) Table Title
Application Priorities Status Analysis All Active Instances

Average Duration Time Analysis Completion Time for All Instances

Active Applications Status Analysis All Active Instances

Infopad Count Infopads Infopad: <App_Name>

Applications Due Today Workload Analysis All Instances Due Today

Overdue Applications Time Analysis Overdue Time for All Active Instances

Application Status Status Analysis Status of All Instances

Table 16   For the Selected Application

Widget Page (Report Type) Table Title
Completed Applications Status Analysis Completed Instances for <App_Name>

Average Application 
Duration

Time Analysis Completion Time for <App_Name> 
Instances

Application Priorities Status Analysis Active Instances for <App_Name>

Active Worksteps Status Analysis Active Worksteps for <App_Name>

Worksteps Due Today Workload Analysis <App_Name> Worksteps Due Today

Overdue Worksteps Time Analysis Overdue Time for Active Worksteps for 
<App_Name> Worksteps
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Chapter 7

Executing and Creating 
Reports

This chapter describes how EMC IT Process Centre (ITPC) Managers can use either JasperReports or the 
ITPC Report Builder to create new reports or use existing reports to further manage and review ITPC 
applications. 

Creating and Deploying Reports Using JasperReport
You can use the extensive reporting capabilities of JasperReports — an open source Java reporting tool — to 
create and execute reports that meet your specific requirements. You may use any JasperReports Designer to 
create your reports. However, ensure that it is saved as a “jrxml” file. You can deploy your JasperReports as 
a common report or specific application report.

Deploying as a Common Report

To deploy your JasperReports as a Common Report in ITPC, copy your report file (jrxml) to 
%APP_SERVER_HOME%\sbm\ebmsapss\common\reports directory, where %APP_SERVER% is the root 
directory of your application server.

Deploying as an Application Report

To deploy your JasperReports as an application specific report in ITPC, copy your report file (jrxml) to 
%APP_SERVER_HOME%\sbm\ebmsapss\<application_name>\reports directory, where 
%APP_SERVER% is the root directory of your application server and <application_name> is the name of 
the application for which this report is being deployed.
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Using a Database other than ITPC Connection Pool

If you want to use a databse other than ITPC, you have to create a file in the same directory where your 
report is stored, with the name <report_name>.properties.datasource. This file should contain 
the JDBC URL, driver class, user name and password. A sample of this file is shown below:

########################################################################
# This file has been provided to set sample jasper jdbc datasource for 
sample jasper report
# jasper.reports.datasource.url:  JDBC URL
# jasper.reports.datasource.driver: Driver Class
# jasper.reports.datasource.user: User
# jasper.reports.datasource.password: Password
########################################################################

jasper.reports.datasource.url=<your_database_url>
jasper.reports.datasource.driver=<your_database_driver>
jasper.reports.datasource.user=<your_database_user>
jasper.reports.datasource.password=<your_database_password>

In order to avoid compilation error(s), make sure that the driver classes already exist in your portalServer 
class path.

Adding JAR files to Jasper Compiler Class Path

To add your custom classes to Jasper compiler class path, follow these steps: 

1.   Open the bpmportal.conf file from the %ITPC_HOME%\conf directory.

2.   Add your jar file separated with “|” token to the 
bpmportal.jasper.compiler.classpath attribute, and save the file.

A sample of this file is shown below:

#   <param name="bpmportal.jasper.compiler.classpath">
#    <alias>Jasper Compiler Classpath</alias>
#    <visible>true</visible>
#    <description>This classpth is used to set jasper compiler for 
reports.</description>
#    <legalvalues>Should contain bpmportal.jar, jasperreports.jar, 
servlet.jar, commons-digester.jar and %APPSERVER%/sbm/WEB-INF/classes in 
classpath format.</legalvalues>
#    <group>CONFINFO</group>
# </param>
bpmportal.jasper.compiler.classpath=@@ITPC_HOME@@/lib/
bpmportal.jar|@@WEBAPP_DIR@@/WEB-INF/lib/
jasperreports.jar|@@WEBAPP_DIR@@/WEB-INF/lib/
commons-digester.jar|<your_class_path>
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Setting Up Jasper Assistant Plugin in BPM Studio
You can use Jasper Assistant plugin with BPM Studio to create your Jasper reports. While installing BPM 
Studio, select the BPM Studio with Eclipse option. You may select other options as per your requirements. 

Download the Jasper Assistant Plugin, JasperAssistant_2.0.0_Eclipse3.0, from 
http://www.jasperassistant.com/download.html, extract its zip file in a directory, and copy only the feature 
and plugin directories to <BPMSTUDIO_HOME> directory. Similarly, also download 
GEF-runtime-3.0.1.zip from http://www.jasperassistant.com/installation.html. Note that the 
GEF-runtime-3.0.1 files starts from default Eclipse directory. Therefore, it is recommended that you extract 
it into temporary directory and then copy the features and plugins directories into your 
<BPMSTUDIO_HOME> directory.

To create a JasperReport using Jasper Assistant plugin in BPM Studio:

1.   Start the BPM Studio. From the Window menu, select Preferences. The Preferences dialog window 
is displayed as shown in the following figure.

Figure 36   Preferences Window
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2.   In the Preferences dialog window, click Jasper Assistant to expand it. Select the Data Source 
option, and click New button. The Selection required window is displayed as shown in the 
following figure.

Figure 37   Preferences Window

1. Click Data Source

2. Click New.

3. Select the Database
Data Source option,
and click OK.
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3.   Select the Database Data Source option from the drop-down list and click OK. The New Database 
Data Source dialog window is displayed as shown in the following figure.

Figure 38   New Database Data Source Window

a. Specify a name, driver, URL, username and password in appropriate text boxes. You can find 
these details in the %ITPC_HOME%\conf\sbmdb.properties file. 

b. In the JAR file 1 text box, specify the absolute path of the classes12_9i.zip file from ITPC. 

c. Click Test to test the data source test.

d. After successful testing, click OK to close the New Database Data Source dialog window. 
Then click OK to close the Preferences dialog window.
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4.   From File menu, select New and then Project. The New Project Wizard opens. 

Figure 39   New Project Window

5.   From the ITPC Wizards, select the BizLogic Application option, and click Next. The New 
Application dialog window is displayed.

Figure 40   New Application Window
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a. Specify the required details, and click Next to continue. 
Figure 41   New Application Window

b. In the Project Location screen, select an appropriate option to create the project in workspace 
or specify the location of a directory where it should be created. 

Figure 42   New Application Window
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c. Click Finish. The Open Associated Perspective confirmation window is displayed. Click Yes 
to close it.

6.   In the BPM Studio, add few worksteps and save the application.

Figure 43   BPM Studio

7.   From the File menu, click New, and then Other. The New dialog window is displayed. 

Figure 44   New Window

a. Click Jasper Assistant to expand it. 
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b. Select the Report option, and click Next button. The New Report Wizard window is 
displayed.

Figure 45   New Report Wizard Window

c. Specify the value(s) as required, and click Next. 
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d. Select the datasource that you created earlier, and click Next.
Figure 46   New Report Wizard Window

e. Specify the SQL query to be used to retrieve report data, and click Next. 
Figure 47   New Report Wizard Window
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f. Select the fields to be used in the report, and click Finish.
Figure 48   New Report Wizard Window

8.   In the BPM Studio, expand the fields tab. Drag the required fields and drop them in the details band. 
You can customize your reports by using Pallete and/or adjusting height/width. You may use 
Preview feature to view the designed report.

Figure 49   BPM Studio
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9.   From the File menu, click Save All and close BPM Studio. An application with the name you 
specified is created in the %BPMSTUDIO_HOME%\Workspace directory. 

10.   Copy this to %ITPC_HOME%\ebmsapps directory. Create a folder with name reports in the 
%ITPC_HOME%\ebmsapps\<application_name> directory. Ensure that the 
<application_name>.jrxml file is copied from the <application_name>\processtemplates directory 
to <application_name>\reports directory. This will define it as a application report. You can also 
copy this file to %APP_SERVER_HOME%\sbm\ebmsapss\common\reports directory to define this 
report as a common report.

11.   Deploy this application from the BPM Studio.

12.   Install the application. The newly created Jasper Reports will be listed in the Report List page of 
the Management module.

Figure 50   Jasper Report in BPM Portal

NOTE:    If you want to specify datasource other than ITPC database, then you have to create the 
<application_name>.properties.datasource file, and enter the details of the new datasource 
in it. For more information, see Using a Database other than ITPC Connection Pool on 
page 67.
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Managing Reports Created Using JasperAssistant

To access the report you created using JasperAssistant through the BPM Portal: 

1.   In the Management module, click Reports > My Reports, to view the Report List page. 

2.   From the Report drop-down list, select the application where you saved the report you created 
using JasperAssistant. In this example, we select testreports. Click Go, and testreports application’s 
reports are displayed in the workspace, as shown in the following figure.

Figure 51   The Report List Page, with a Report from JasperAssistant 

3.   For JasperReports, a drop-down list is displayed in the View Format column that provides options 
for the report’s presentation. Options include: HTML, PDF, RTF, CSV, XLS and XML. 

The XML and XLS options display a link. You can right-click on that link and save the report in 
your machine to view it locally. 

Select an application
and click Go.

JasperReport from
BPM Studio.
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4.   JasperReports may also include Broadcast and Schedule options. Click the Broadcast icon ( ) to 
open the Broadcast Report page, where you can enter data to automatically email the report to 
specific addresses. As shown in the figure below, you can enter the subject, add comments and 
select the format of attachments. Options include: HTML, RTF, Text and PDF.

Figure 52   Broadcast Report Page

5.   To run and distribute the report on a specific date and on a predetermined frequency:

a. Select the Yes option in the Schedule section. 

b. Enter a date in the Date box or click the Select Date icon to display a calendar that facilitates 
the date entry. Select an option from the Frequency drop-down list. 

c. Click Save to execute the Broadcast and Schedule operations. ITPC saves these settings after 
your confirmation. 

6.   To view the report, select this JasperReport in the Report List page, select a format from the View 
Format drop-down list, and click View. 

To modify the report, return to BPM Studio. Use ITPC to only view and/or run the reports developed in 
BPM Studio with JasperAssistant plugin.

Creating and Executing Reports in BPM Portal
Using the Management module, you can define and execute single application reports, multi-application 
reports, and external reports. In the Management module, click Reports > My Reports, to view the Report 
List page. This page presents the three possible scenarios explained in the following table:

Table 17   Reports Display Scenarios

If there are . . . You will see . . .
No ITPC applications specified to 
be monitored by the user.

No Records Found.
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The Report List page enables you to define your own business reports. Use this page to:

•   Execute existing reports.

•   Create reports for a single application, multiple applications, and external report servers.

•   Test a new query.

•   Modify existing reports.

•   Define parameters for reports.

•   Remove existing reports.

You may have defined several reports in the selected application. Select one of the listed reports and click 
View to execute the report and view each report instance, listed under the report’s defined attributes (for 
more information, see Running an Existing Report on page 81). To create a report, use the Add Report 
button at the top of the page (for more information, see Creating Application (Query) Reports on page 83).

Figure 53   Report List Page

No existing or predefined reports 
available.

No Records Found.

Existing, predefined reports for 
selected ITPC applications, 
multiple ITPC applications, or 
externally defined reports.

The following information:

• The type of report

• The application name for which the reports are defined

• The name of each report

• The description of each report

• The format of the report

• The number of reports, displayed as Total: x

Table 17   Reports Display Scenarios

If there are . . . You will see . . .

Select the report type and
click Add Report to create
the selected type of report

Select a report
and click View
to run a report

Select the report type and
click Go to list all available

reports of that type
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About Multiapplication Reports

Creating multiapplication reports enables you to monitor and manage multiple applications at the same time. 
For example, managers can create a report that lists all application instances for a particular user 
independent of the application. You can also define reports that perform filtering on various task attributes. 

For more information about creating or modifying Multiapplication reports, see Creating Multiapplication 
Reports on page 87. Select Multiapplications from the Report drop-down list on the Report List page to list 
the available MultiApp reports. 

About External Reports

Creating external reports enables you to access and execute reports using external report servers. You can 
send parameters and values to report servers which generate reports accessible through the Management 
module of the BPM Portal. The following table describes the types of external reports.

Running an Existing Report
To execute an existing report, complete the following steps:

1.   In the Management module, click Reports > My Reports, to view the Report List page. 

Table 18   External Report Types

Report Type Description
Crystal 
Reports

If the Crystal Reports tool is installed on your network, this option accesses all available 
reports generated through this application.

HTML Similar installation as Crystal Reports except the default URL button is disabled and is not 
used to create HTML reports. Reports are generated using external reporting servers or 
ASP in HTML format.

BizSQL Reports generated using BizSQL. This capability is integrated with ITPC, enabling you to 
place SQL statements in a file (you must use the *.bizsql extension for all databases) for 
execution by the Management module. 
This file is stored in the <App_Server>\sbm\BizManage\reports folder under the path that 
your application server is using. For example, For example, for Pramati application server, 
the path is 
%ITPC%\pramati\server\nodes\portalServer\archives\public_html\sbm\BizManage\reports
.
Once executed, ITPC formats the results and presents the output using standard HTML. 

Users can view only those BizSQL reports for which they have been given permissions. 
These permissions are controlled using the Permission Create page in the Administration 
module. For more information on BizSQL security, see the BPM Portal Administrator’s 
Guide.
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2.   Select the type of report that corresponds to the existing report you want to execute from the 
Reports drop-down list at the top of the page, and click Go (see the figure below). You can choose 
between Multiapplications (draws data from more than one application), All Reports (lists all 
available applications), External Reports (integrates with an external report server), or select a 
specific application (provides a Query report or an Infopad report for a single application).

Figure 54   Report List Page, with Report Types

3.   Select a report from the list of reports and click View to run the report and display it in the View 
Report page (see the following figure). The report name, in this case QueryRepwithTaskType, is 
displayed above the table, and each process instance within the report is listed as a row in the table. 
Columns represent attributes you selected when creating the report (see Creating Application 
(Query) Reports).

If you select an Application (Query), Multiapplication or External (BizSQL) report, then you can 
click the instance name from the Name column to see the Chart View of the selected instance. Click 
Cancel to close the Chart View and go back to the View Report page.

Figure 55   Running a Selected Report

Select a report type, then
click Go to display reports of

the type in the table below.

Report Name

Report’s Process Instances
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Creating Application (Query) Reports
This section describes how to use ITPC’s Report Builder to define new queries and create reports of 
application and task instances from a single application. After first defining a new query, the user can then 
save the defined query as a new report.

Note:    See Creating External Reports on page 90 for more information on defining a query and creating 
External Reports.

To define a new query:

1.   From the Report List page, select the report type from the drop-down list at the top of the page 
(refer to Figure 53 on page 80).

Selecting Query Report enables you to create a report from one of the installed applications.

2.   Click Add Report, and the Add Application (Query) window for the report type you chose in the 
preceding step opens, as seen in the following figure.

Figure 56   Add Report Window

3.   Select the application for which you want to create a report from the Application drop-down list.

4.   Click Query to display the Query dialog window (see Figure 57). ITPC selects the Application 
Report type and the Application Attributes tab by default. The list of attributes shown in this 
Application Attributes tab differs from the attributes associated with a Multiapplication Report.
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5.   Select one of the following report types:

• Application Report. ITPC retrieves only the application attributes, which are displayed in 
the panel on the left of the Query dialog window. 

• Task Report. As shown in the following figure, ITPC retrieves application attributes and all 
task attributes (workitems) related to the application that have been assigned to the user.

Figure 57   Application Attributes Tab in Query Dialog Window

6.   Select the application and/or task attributes you want to include in the query definition (which can 
later be saved as a new report).

The Name attribute is mandatory and is always selected.

7.   Click the Filters tab.

The Filters tab (see Figure 58) enables you to customize the information presented in your reports. 
Select attributes for the filter from those listed in the Select Attributes panel. The contents of the 
Define Filter panel changes to match the particular attribute selected in the Select Attributes panel. 

Select a Report Type

Select a Task Attribute

Select an Application
Attribute
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8.   To define a filter, type the reference value into the Name text box in the central section of the 
Query dialog window, or click the ellipsis button ( ) to the right of the Name text box to have 
Report Builder display the list of all available values that have been defined.

Figure 58   Filters Tab in Query Dialog Window

9.   After selecting and defining a filter to apply to the new query definition, click Add.

As shown in the figure above, ITPC adds the filter to the list in the Current Filters panel. Use the 
Delete button to remove selected filters from this list.

10.   Add additional filters, if required.

Click ellipsis button to
see available values.

Click Add to apply
filters to the query.

Define Parameters... 
button
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11.   Click the Options tab and enter a brief description in the activated text box (see the following 
figure).

This optional description will appear on the Reports page next to the report name (refer to Figure 
53 on page 80).

Figure 59   Options Tab in Query Dialog Window

12.   Click Apply to view the results, which ITPC displays in the View Report page.

13.   Refine the results, if necessary, and click Apply to view the new result in the View Report page. 

In this page, you can click the instance name from the Name column to see the Chart View of the 
selected instance. Click Cancel to close the Chart View and go back to the View Report page. 
Click Cancel to close the View Report page and go back to the Query dialog window.

14.   To create a new report, click Save As. 

15.   In the Save As dialog box (see the following figure), enter a name for the new report in the Report 
Name box and click Save.

Figure 60   Saving a Query to Create a Report

Note:    ITPC cannot display a report that includes the forward slash (/) in its name. Therefore, it is 
recommended that it should not be used in the report name.
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16.   Click Close to exit the Report Builder. 

ITPC displays all saved reports for the selected report type and the selected application in the 
Select a Report panel (refer to Figure 53 on page 80.).

Creating Multiapplication Reports
This section describes how to use ITPC’s Report Builder to define new queries and create reports of 
application and task instances from multiple applications. After first defining a new query, the user can then 
save the defined query as a new report.

Note:    See Creating External Reports on page 90 for more information on defining a query and creating 
External Reports.

To define a new query for multiple applications:

1.   From the Report List page, select Multiapplication Report from the drop-down list at the top of the 
page (refer to Figure 53 on page 80).

Selecting Multiapplication Report enables you to create a report from all or multiple installed 
applications.

2.   Click Add Report, and the Add Multiapplication Report window opens, as seen in the following 
figure.

Figure 61   Add Multiapplication Report page 

3.   Select one of the applications for which you want to create a report from the Unselected 
Applications panel and click Add to add it to the Selected Applications panel.

4.   Click Add All to add all the applications listed in the Unselected Applications panel to the Selected 
Applications panel. Click Remove or Remove All to delete one or all of the applications listed in 
the Selected Applications panel.
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NOTE:    The list of selected applications including delimiters should not exceed 4000 characters.

5.   Click Query to display the Query dialog window (see Figure 57). ITPC selects the Application 
Report type and the Application Attributes tab by default. The list of attributes shown in this 
Multiapplication Attributes tab may differ from the attributes associated with a single Query report 
(for a single application).

6.   Follow procedures described in steps 5-16 in Creating Application (Query) Reports on page 83 to 
complete the creation of a multiapplication report.

Defining Parameters for Application and Multiapplications 
Reports

ITPC’s Management module enables you to create parameters for application attributes, generating dynamic 
reports based on values that can be specified at the time the report is executed. After defining one or more 
parameters, ITPC prompts you to supply these values when you execute the query or report.

To define a new parameter, complete the following steps:

1.   In the Query dialog window, click the Filters tab, then Define Parameter (refer to Figure 58 on 
page 85), to open the Define Parameters dialog window (see the following figure)

Figure 62   Define Parameters Dialog Window

2.   Type the name of the parameter in the Name box and enter the corresponding user prompt.

3.   Enter a default value for the parameter.

4.   Click Add to register the parameter. The parameter appears in the Current Parameters panel, and 
can be used for the current report or any future report.

Whether creating a query or modifying a report, you can define parameters of report filters that will generate 
reports based on a specific set of selected data. 
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To define parameters for report filters, complete the following steps:

1.   In the Query dialog window, click the Filters tab.

2.   Select attributes of the filter parameter from the Select Attributes panel.

3.   Set the Use Parameter check box.

4.   Click Select Parameter.

ITPC displays available parameters in the drop-down list illustrated below.

Figure 63   Selecting a Filter Parameter

5.   Select a parameter from the Select Parameter drop-down list.

6.   Click Add.

ITPC adds the filter parameter to the list displayed in the Current Filters panel. 

7.   Click Save to save the report.

Note:    While executing the query or report, a prompt appears to supply the defined parameter. Enter the 
value and click Go to generate the report.

Report Versioning

You can run a multiapplication report on an application that has more than one versions. You can save this 
report. If you add more versions of this application, the multiapplication report will automatically report on 
each added version, but only if these versions have the same application name; for example, Approval_V4, 
Approval_V5, Approval_V6.

Select a parameter
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Creating External Reports
ITPC enables you to integrate externally defined reports. Use the ITPC Report Builder to create external 
reports that can access and execute reports using external report servers.

To define an External Report, complete the following steps:

1.   From the Report List page, select External Report from the Report drop-down list at the top of the 
page (refer to Figure 53 on page 80).

Selecting External Report enables you to create a report that can access and execute reports using 
external report servers.

2.   Click Add Report, and the Add External Report page opens, as seen in the following figure.

Figure 64   Add External Report Page

3.   Select the generator of the report from the Type drop-down list. Options include Crystal, HTML, 
and BizSQL. See Table 18 for a description of the External report types.

4.   Click Query. ITPC displays the Query dialog window opened by default to the Custom Report tab, 
as illustrated in the following figure. You can change the report generator, if required, using the 
Report Type drop-down list. 

Figure 65   Query window for External Report, Custom Report Tab

5.   When creating HTML reports, enter the URL of the HTML server in the Report URL box. For 
HTML, the default URL button is enabled only if the value is available in the .conf file; otherwise 
the default URL button is disabled and therefore cannot be used as a basis for creating the reports.

Select a Report Generator
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6.   When creating Crystal Reports, enter the URL of the Crystal Report server in the Report URL box.

Alternately, click the Default URL button to have ITPC fill in the default Crystal Report Server 
specified in the bpmportal.conf configuration file, if available.

7.   When creating BizSQL reports, specify a file name instead of a URL in the Filename box (see 
Figure 67). This file contains the SQL statements for execution by ITPC. The BizSQL files are in 
the <App_Server>\sbm\BizManage\reports directory. The file extension is *.BizSQL, which works 
for all databases. The path to the BizSQL file depends on the application server you are using. For 
more information see Table 18.

NOTE:    If you want to include the Chart View in your BizSQL report, then your query must contain 
following parameters from ITPC database:
process_template_name, process_template_id, 
process_instance_name and process_instance_id

Note the following conditions when using BizSQL syntax:

a. You must use the exact syntax when developing BizSQL reports. The following parameterized 
sql query is provided as an example:
select * from processinstance where processinstance.creator = '<%= who 
%>'
where the parameter value must be enclosed within the <%= %> tag, and you must enter a 
space before and after the query name. The tag must also be enclosed with single quotes.

Optionally, you may also use non-parameterized SQL queries, the syntax for which is as 
shown in the following examples (in these examples, * = all): 
Select * from processinstance where processinstance.creator IN 
'<%= who %>'
Select * from processinstance where processinstance.creator = 
'<%= who %>'
Select * from processinstance where processinstance.creator NOT 
'<%= who %>'
Please make sure that you enter the SQL query as is shown in the above examples with 
appropriate changes as per your requirements.

b. Do not put a semicolon at the end of an Oracle SQL statement; it causes an invalid character 
error.

c. Use the following syntax if you want to display a valid field under a customized label in BPM 
Portal:
select field1 AS label1, field2 AS label2, field3 as label3,... 
from table name
or in a specific example:
Select PROCESSINSTANCE.PROCESSINSTANCENAME AS Task from 
PROCESSINSTANCE
where PROCESSINSTANCE.PROCESSINSTANCENAME is the field, Task is the label and 
PROCESSINSTANCE is the table name.
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8.   To define parameters for External reports:

a. Enter a parameter name and value in the Parameter Name and Parameter Value boxes 
respectively, and click Add. Use these parameters to uniquely identify the report. 

b. ITPC adds the parameter definition to the Current Parameters drop-down list, as illustrated in 
the following figure.

Figure 66   Specifying Report Parameters and Values

c. To add more parameters, repeat the preceding steps.

d. To remove a parameter, select it from the Current Parameters drop-down list and click 
Remove.
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9.   When using BizSQL as the report generator, ITPC substitutes the parameters into the file containing 
SQL statements, enabling you to define parameterized SQL statements (see the following figure). 
When entering parameters and values, follow the SQL syntax. For example, in the Parameter Name 
box, use the following format to enter parameter names in the BizSQL query file: 

parameter_name or ‘parameter_name’

As shown in the example above, the parameter value may be given without single quotes or within 
single quotes, depending on the SQL syntax. For example, if the parameter’s value is part of a 
Where clause, it is in single quotes.

Figure 67   Specifying Parameters for BizSQL

10.   Click the Options tab and enter a description of the new report in the Description text box, as 
shown in the following figure. This description will appear on the Report List page next to the 
report name (see Figure 53 on page 80).

Figure 68   Adding a Report Description
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11.   Click Apply to view the results, which ITPC displays in the Report Parameters window.

12.   Refine the results, if necessary, and click Submit to view the new results in the View Report page.

In this page, you can click the instance name from the Name column to see the Chart View of the 
selected instance. Click Cancel to close the Chart View and go back to the View Report page. 
Click Cancel to close the View Report page and go back to the Query dialog window.

13.   Click Save As to create a new external report, opening the Save As dialog box (see below).

Figure 69   Saving a Query to Define a Report

14.   Enter a name for the new report in the Report Name box and click Save. Do not use the forward 
slash (/) character in a report name. ITPC cannot display a report that includes ‘/’ in its name.

15.   Click Close to exit the Report Builder. 

ITPC displays all saved reports on the Report List page for the selected report generator (as shown 
in Figure 64 on page 90).

Modifying an Existing Report
Many of the same procedures that were used to create a new Query (Application), Multiapplication or 
External report can be used to modify an existing report.

To modify an existing report:

1.   In the Management module, click Reports > My Reports, to view the Report List page (see Figure 
54 on page 82), and then select a report from the Report Name column. 

2.   Click Edit Report ( ) icon, displayed in the Report Name column, and a window displaying 
existing settings for the selected report opens.
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3.   Follow the procedures, as necessary, in steps 3 - 14 in Creating Application (Query) Reports on 
page 83 or in steps 4 - 16 in Creating External Reports on page 90.

Figure 70   Modifying an Existing Report

Removing an Existing Report
To delete an existing report, navigate to the Report List page. Select the report to be deleted from those 
listed on the page, and click Delete (See Figure 53).

Using Task Filtering for Reports
ITPC provides extended task filtering capabilities for more effective report building. Using task filtering, 
managers can create reports filtered on task attributes. Managers are able to define complex task reports 
through the existing BPM Portal interface, and don’t need to navigate to the BizSQL report facility.

Note:    The task filter cannot entirely replace the BizSQL report facility, which can manipulate any 
database table, not just the workstep and workitem tables.

For example, you can specify which tasks are to be displayed, and can choose from all the tasks of a 
particular instance to none of the tasks of a particular instance. The Report Builder supports the definition of 
filters on the following task items:

•   Task name

•   Task performer

•   Task status

•   Task priority

•   Task start/end time

The task filtering feature is built into the Report Builder interface on the Report List page. With task 
filtering built into the interface, you can specify conditions of any task attribute and not lose the previous 
capabilities, such as filtering process instances based on the priority of a particular workstep.
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For example, the manager of a Hiring application can list all the instances with an Evaluate Resume task that 
has an Active status and a High priority. Furthermore, if the report was defined as a task report, the list of 
worksteps that are only active will be displayed, as well as all tasks (active as well as completed, removed 
and suspended) related to the instances. 

To use task filtering in reports:

1.   For new reports, from the Report List page, click Add Report. For existing reports, select 
appropriate options from the Type and Applications panels, and click Query. For existing reports, 
select the report you want to revise and click Modify.

2.   The Query dialog window appears, open to the Application Attributes tab. Select Task Report 
from the Report Type drop-down list in the Query dialog window (see the following figure).

Figure 71   Application Attributes for Task Reports

3.   From the tasks listed in the right panel of the Query dialog window, select the tasks to be displayed 
in the report.

4.   From the attributes listed in the left panel of the Query dialog window, select the workitem 
attributes to be displayed in the report.

5.   Click the Filters tab (see Figure 72).

To define a filter for workitem attributes, select an attribute from the Select Attributes panel. Each 
time the user selects one of the attributes, the contents of the Define Filter panel changes. Type a 
reference value into the text box in the Define Filter panel, or click the ellipsis button to the right of 
the text box ( ) to let the Report Builder display a list of available values. After defining the 
filter, click Add. ITPC adds the filter to the list in the Current Filters panel. Add additional 
workitem attribute filters as required.

To define a filter for task attributes, select an attribute from the Task Attributes panel in the lower 
left of the page (see Figure 72). Each time the user selects one of the task attributes, the contents of 
the Define Contents panel changes. Enter appropriate information in the Define Filter panel. After 
defining the filter, click Add. ITPC adds the task attribute filter to the list in the Current Filters 
panel. Add additional task attribute filters as required.
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NOTE:    In the case of task reports, you will find another option, <Any Task>, in the workitem 
sub-panel to define a filter on a task attribute independent of the workitem name. 

Figure 72   Filters Tab for Task Reports

6.   Click the Options tab. Enter a brief description of the report in the activated text box. 

The description will appear on the Reports page next to the report name.

7.   Click Save As when all task report filters have been defined.

8.   Enter the name of the new report in the Save As dialog window, and click Save.

9.   Click Close to exit the Report Builder. 

ITPC displays all saved reports on the Report List page (refer to Figure 53 on page 80).

Updating Previously Created Reports with Task Filtering

It is possible to open a report created in an earlier version of ITPC and add the task filtering functions to the 
report.

Defining Infopad Reports
BizPulse uses a data structure called an infopad to store:

•   Application parameters (e.g., the list of product purchase limits for different departments)

•   Rule parameters (e.g. the critical threshold for a resource load)

•   Any other global data that the rules may require. 

Infopads are stored in the ITPC repository. An infopad is a single- or two-dimension table, which is 
composed of cells. Each cell is a data structure that contains a cell slotname and a value. For more detailed 
information on infopads, see the Infopads chapter in the BizPulse User’s Guide.

Workitem Attributes

Task Attributes
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ITPC enables you to create a detailed analysis report of an infopad associated with one or more applications. 
These reports are called infopad reports.

In the Report List page, select Infopad Report from the list adjacent to the Add Report button. You can then 
perform the following actions on the infopad reports.

ITPC offers a highly visual set of charts for infopad reports, which can help you monitor ITPC applications 
at a higher level. Select from one of the following analysis formats:

•   Table

•   Graph

•   Table & Graph

•   Excel Spreadsheet

To create a detailed analysis report using infopads, complete the following steps:

1.   In the Report List page, select Infopad Report from the drop-down list, and then click Add 
Report. The Add Application(Infopad) Report page opens. 

Figure 73   Add Application(Infopad) Report Page

Table 19   Infopad Report Actions

Option Action
Add Report button Create a new infopad report.

Edit Report icon Modify an existing infopad report.

Delete button Delete the selected infopad report.

View button Display the selected infopad report.
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2.   Specify the information and format for the infopad report. The following table lists infopad report 
options:

To show your data correctly in the selected Chart type, you must define more than one row or 
column in either the row dimension or the column dimension. For example, the predefined 
MyTaskReport_Ver2 infopad contains 4 row/columns in one dimension and one row/column in the 
other. To display the Area Chart and Stacked Area Chart types correctly for infopads, make sure that 
you select an option from the Column drop-down list that contains at least one row and more than 
one columns.

Note:    You can use the Permission Create page in the Administration module to control the permissions 
to multiple infopads. For more information on BizSQL security, see the BPM Portal Administrator’s 
Guide.

3.   Click Preview. A new window opens, displaying the Infopad Report based on the specified 
settings. Click the Graphical View tab, to verify whether your infopad report presents the data as 
required or not. Click Close this winndow to return to the Add Application (Infopad) Report page.

4.   Click Save to save the current report. Click Save & Add New to save the current report and reload 
the page to allow you to add another report. 

Click Reset to delete your changes and display the original settings.

Click Cancel to delete your changes and return to the previous page.

Table 20   Infopad Report Options

Option Description
Application Select an application for which you want to create a report.

Report Name Specify a name for the report.

Report title Specify the title that will be displayed on the infopad report.

Report description Specify the description that will be displayed on the infopad report.

Infopad Select the infopad you want to analyze from the drop-down list.

Row and Column ITPC automatically chooses a row and column for the report when you select the 
infopad, but you can change these default selections.

Slice on ITPC automatically chooses the dataslot displayed in the infopad composer, but 
you can change the default selection.

Chart type Choose from the following: Line Chart, Pie Chart, Area Chart, Multi-row Bar 
Chart, Multi-column Bar Chart, Stacked Bar Chart, or Stacked Area Chart.

Pie Chart On Select Row or Column, if the Pie Chart option was selected in the Chart Type 
drop-down list.

Default view Choose from the following: Table, Graph, Table & Graph, or Excel.

Layout Choose either Horizontal or Vertical. The layout option applies only to Table & 
Graph views.

3D Check to display the analysis in 3D charts. The three-dimensional effect does 
not apply to any area or stacked area chart types.

Value ITPC automatically chooses the numerical value for the row or column if using 
the pie chart, but you can change the default selection.

Width and Height ITPC automatically chooses the physical size of the infopad report, but you can 
change the default selection.
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Chapter 8

Using the Instance Manager

In today’s business environment, a system may have hundreds of performers creating thousands of 
instances. As a user in this type of system, you may want to modify large numbers of instances, worksteps 
and tasks in batches, rather than on a more time-consuming, one-by-one basis. The Instance Manager 
enables you to efficiently manage existing instances and their tasks in batches, by performing the following 
procedures:

•   Search through all existing instances and their tasks. Use the Instance Manager’s Search function 
to filter through instances and tasks for date, name, creator, manager and priority attributes.

•   Update batches of process instances and worksteps. All instances or worksteps, system attributes 
or dataslots retrieved by the Instance Manager’s Search function can be updated with a single click.

•   Dynamically change instance properties at run-time. Instance Manager enables you to change 
application properties at the instance level and the task level, even when the application is up and 
running. You can change instance and task properties or change attribute or dataslot values at 
run-time.

Note:    Instance Manager only works with existing instances and their tasks. To change template-level 
properties at run-time, you must use other Management features.

•   Perform bulk updates of instances in Management reports. You can quickly update selected 
groups of user defined dataslots. 

•   Reassign tasks in batches. In some systems, you, as ITPC Manager, can create hundreds of 
instances of an application, which are automatically assigned to you. You can then use the Instance 
Manager to reassign all or a selected batch of tasks to a specific performer. In cases of employees on 
vacation or leaving the company, you can also reassign batches of these tasks to a specific 
performer.

•   Assign “Available Status” tasks to specific performers. In ITPC, if the performer of a task is a 
group and the role is “any”, the status of this task will be “Available” to any member of the group 
until it is actually assigned to a specific performer. Using Instance Manager, you can conveniently 
retrieve such groups of tasks and assign a batch of them to a specific performer or to another group.
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Launching the Instance Manager

The Instance Manager feature can be described as a BizSolo application running in the Management 
module. To launch the Instance Manager from the Management module of BPM Portal, in the Management 
module, click the Instance Manager menu and select one of the submenu options.

In order for the Instance Manager to function, BizLogic Server must be running. When you start Instance 
Manager, it first verifies that BizLogic Server is running. If it is not running, it displays a warning message. 
When this warning is displayed, you must log out of BPM Portal, launch BizLogic Server, and log in to 
BPM Portal, and then access Instance Manager again.

Instance Manager enables you to select the application that you want to monitor or manage.You can only 
select one application in the Instance Manager.

The Instance Manager enables you to manage at the following levels:

•   Instance Level, where you can:

• Click Search Criteria to search for and view a list of process instances, and change one, a 
selected batch, or all process instance properties in the selected application.

• Click Display Attributes to modify dataslots in the selected application.

• Click Reports to modify system attributes in BizManage reports in the selected application.

•   Task Level, where you can:

• View the tasks for all performers, or submit search criteria to find a specific performer. 

• Reassign one, a selected batch, or all assigned tasks of a performer, or reassign the available 
tasks of a performer.

•   Workstep Level, where you can:

• Click Search Criteria to search for a specific, or a selected group of, worksteps.

• Click Worksteps to update all, or selected, worksteps.

• Click Display Attributes to modify dataslots in the selected application.
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Updating Process Instances

To update one process instance, a selected batch of process instances, or all process instances:

1.   In the Management module, click Instance Manager > Instances, to view the Search Instances 
page, as shown in the following figure. 

Figure 74   Search Instances Page

2.   Select an application from the Application drop-down list at the top of the Search Instances page. 
To further define your search on a specific attribute, select the Attributes option, and click Go.

The Search Instances page, contains the Search Criteria, and Display Attributes tabs. It enables 
you to refine your search. 

3.   Click the Search Criteria tab, and enter relevant data in the Instance Name, Creator, Priority, Start 
Date and Due Date boxes. 

a. In the Instance Name box, enter the name of the Instance that you want to retrieve. Note that 
the search engine is case sensitive.

By default, an asterisk (*) is entered, which means that all instances will be displayed.

b. In the Creator box, enter the name of the Creator that you want to retrieve in the text box. Note 
that the search engine is case sensitive. By default, an asterisk (*) is entered, which means that 
all creators will be displayed. Alternatively, click the Edit Creator icon to open the Search 
Users page (for more information, see Searching Users on page 27).

c. In the Priority box, select an option from the drop down list. The option “All” is selected by 
default.

d. In Start Date and Due Date boxes, specify a time period from the options in the corresponding 
drop-down list. Alternatively, click the Select Date icon (  ) to set the respective start date 
or due date. For more details, see Specifying a Date on page 26. By default, all dates are 
specified.
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NOTE:    If you use the defaults and make no entries on the Search Instances page, a list of all active 
instances for the selected application will be returned by default.

4.   Click the Display Attributes tab. It displays a list of dataslot attributes and dataslots. Select the 
check boxes for the attributes and/or dataslots that you want to change. 

NOTE:    Dataslots of type Document, Object and XML are not displayed in the Display Attributes tab.

5.   Click Search to retrieve all instances that meet the search criteria you have specified.

6.   The search results are presented in the Instance List page (see Figure 75). This page contains two 
frames: the top frame displays all instances you had selected in step 3 and dataslots that you had 
selected for display in step 4; and the bottom frame allows you to apply common values to selected 
dataslots.
As seen in the top frame, instances are presented in a tabular format, with each row representing an 
instance. Instance name and dataslots are displayed in columns. 

Figure 75   Instance List Page 

If your search has retrieved many instances, they will be presented in multiple pages. To manage 
the contents of the list, you can sort them. To navigate through the pages, you can use the paging 
controls. For more details about these operations, see Exploring BPM Portal on page 21.

Note:    You can customize the number of instances that are displayed on a single page by modifying the 
bpmportal.conf file.

7.   To modify data for specific instances, click the link in the Instance column. The details of the 
selected instance are displayed in the bottom frame. 

a. Enter new information about the displayed dataslots in the corresponding value boxes for the 
instance(s). 

b. To apply common values to selected instances and/or clicked instance displayed in the top 
frame, make modifications to the dataslot values displayed in the bottom frame (see Figure 75 
on page 103), and click Apply. You can also apply common values to all instances displayed 
on the screen by selecting the check box in the heading of the table in the top frame. 
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c. Click Save to save the new data after your confirmation.

To reset the form and remove the information you just entered, click Reset. To cancel the 
action and exit the current page, click Cancel.

8.   Click Update All to apply common values to all instances displayed on all pages. A Warning 
appears, stating that all instances for the selected application will be updated and asks if you want 
to continue. You cannot undo this operation, so make sure all information is correct. Click OK and 
a Confirmation message appears, indicating the update was successful. Click OK to return to the 
Instance List page.

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current page, click Cancel.

Updating Instances Using Reports

To perform a bulk update of user defined dataslots that are in an existing report (i.e., a report that you have 
previously defined):

1.   In the Management module, click Instance Manager > Instances, to view the Search Instances 
page.

2.   Select an application from the Application drop-down list at the top of the Search Instances page. 
To further define your search on a specific report, select the Reports option, and click Go.

NOTE:    Dataslots of type Document, Object and XML are not displayed.

3.   BPM Portal displays a list of ‘Application’ reports for the selected application, as shown in the 
Figure 76 on page 104. Select a report, and click Search, to open the Instance List page. 

NOTE:    Seach does not list the reports designed in the JReport Designer.

Figure 76   Reports List Page

4.   Follow procedures similar to those described in steps 6 - 8 in Updating Process Instances on page 
102.
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Removing Instances

As a ITPC Manager, you can remove instances created by you as well as by others.

1.   Follow the procedure described in steps 1 - 6 in the Updating Process Instances on page 102 to 
locate the instances for removal.

2.   If you want to remove only a few instances, select them from the top frame and then click Remove. 
To remove all instances, click Remove All.

Reassigning Assigned Tasks

To reassign one assigned task, a selected batch of assigned tasks, or all assigned tasks to specified 
performers:

1.   In the Management module, click Instance Manager > Tasks, to view the Performer List page.

2.   Select an application from the Application drop-down list. 

3.   Select Assigned from the Task Type drop-down list, and click Go. The Performer List page is 
displayed, as shown in the following figure. 

Figure 77   Performer List Page

4.   Before you reassign tasks, you need to select the performers whose tasks you want to reassign. To 
locate specific performers, use the search functions on the Performer List page.

a. To search for all performers for a specific search criteria, enter an asterisk (*) in that search 
field. 
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b. The asterisk also serves as a wild card for the Performer box. For example, you can search for 
users named McPherson by entering any of the following:

• Mc* locates all performers with a name beginning in Mc.

• *pher* locates all performers with names containing “pher”.

• *son locates all performers with a name ending in “son”.

• M*n locates all performers with names starting with M and ending with n.

c. Click Submit. The Reassign Assigned Tasks page is displayed.

5.   The Reassign Assigned Tasks page (see the following figure) enables you to reassign an assigned 
task (i.e., change the performer property of a task). This page contains two frames: the top frame 
lists the specified performers for the selected application; the bottom frame enables you to select a 
common performer for all the instances listed in the top frame.

Figure 78   Reassign Assigned Tasks Page

6.   On this page you can perform the following functions:

a. To reassign the selected task(s) to a common performer:

i.  Select one or more specific task check box(es) in the top frame. 

Note:    You can select the check box in the column header to select all the tasks on the current page.

ii.  Enter a performer’s name in the Common Performer box or use the Edit Performer 
icon ( ) to open the Search Users page, where you can search for, then add, a specific 
performer.

iii.  Click Apply. The selected tasks are reassigned to the specified performers after your 
confirmation.

iv.  Click Save. ITPC saves the current settings. 
BPM Portal Manager’s Guide 106



b. To reassign all task(s) across all pages to a common performer:

i.  Enter a performer’s name in the Common Performer box or use the Edit Performer 
icon ( ) to open the Search Users page, where you can search for, then add, a specific 
performer.

ii.  Click Reassign All to reassign, with one click, a batch of tasks to various performers. A 
warning appears, stating that all tasks for the selected application will be reassigned and 
asks if you want to continue. You cannot undo this operation, so make sure all information 
is correct. Click OK. All tasks are reassigned to the specified performers after your 
confirmation.

Reassigning Available Tasks

If the performer of a workstep is a list of names or a group with the role of “any”, then its tasks have an 
Available status when they are created, and remain in this status until you assign them to a specific 
performer. To reassign one available task, a selected batch of available tasks, or all available tasks to 
specified performers:

1.   In the Management module, click Instance Manager > Tasks, to view the Performer List page.

2.   Select an application from the Application drop-down list. 

3.   Select Available from the Task Type drop-down list, and click Go. The Performer List page is 
displayed. 

4.   Before you reassign tasks, you need to select the performers whose tasks you want to reassign. To 
locate specific performers, use the search functions on the Performer List page. After selecting a 
user, click Submit.

5.   The Reassign Available Tasks page (similar to the Figure 78, Reassign Assigned Tasks page) 
enables you to reassign an available task. This page contains two frames: the top frame lists the 
specified performers for the selected application; the bottom frame enables you to select a common 
performer for all the instances listed in the top frame.

6.   The procedures for reassigning available tasks are very similar to procedures described in step 6 in 
Reassigning Assigned Tasks on page 105.

Updating Worksteps

You can now update data at the workstep level. The bulk update feature for worksteps allows you to enter 
search criteria for instances, select specific worksteps and choose which dataslot attributes will be displayed. 
To update one workstep, a selected batch of worksteps, or all worksteps:

1.   In the Management module, click Instance Manager > Worksteps. The Search Worksteps page is 
displayed.
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2.   The Search Worksteps page (see the following figure) contains three tabs: Search Criteria, where 
you can select one or more instances; Display Attributes, where you can choose which dataslot 
attributes will be displayed; and Worksteps, where you can select one or more worksteps.

Figure 79   Search Worksteps Page

3.   Select an application from the Application drop-down list, and click Go. 

4.   The Search Worksteps page has a format similar to the Search Instances page. Please refer to the 
procedures described in Step 2 in Updating Process Instances on page 102.

5.   Use the Search Criteria tab to specify search criteria that will locate and display worksteps of the 
selected application that meet the search criteria. Ensure that you have selected Activity from the 
Workstep Type drop-down list.

6.   Open the Display Attributes tab to display a list of dataslot attributes and dataslots. Select the check 
boxes for the attributes and/or dataslots that you want to change.

7.   Open the Worksteps tab to specify the worksteps you want to locate.

8.   Click Search to retrieve all workitems that meet the search criteria you have specified.
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9.   The search results are presented in the Workstep List page (see Figure 80). This page contains two 
frames: the top frame displays all worksteps selected in step 5, and identifies their associated 
instance as well as dataslots that you had selected for display in step 6. The bottom frame allows 
you to apply common values to selected dataslots. 

As seen in the top frame, worksteps are presented in a tabular format, with each row representing a 
workstep. Workstep values are represented as columns.

Figure 80   Workstep List Page 

If your search has retrieved many worksteps, they will be presented in multiple pages. To manage 
the contents of the list, you can sort them. To navigate through the pages, you can use the paging 
controls. For more details about these operations, see Exploring BPM Portal on page 21.

Note:    You can customize the number of worksteps that are displayed on a single page by modifying the 
bpmportal.conf file.

10.   To modify data for the selected worksteps, click the link in the Instance column. The details of the 
selected workstep are displayed in the bottom frame. 

a. Enter new information about the displayed dataslots in the corresponding value boxes for the 
workstep(s). 

NOTE:    If you change the performer from the Workstep List page, this change will be effective only 
when that workstep is reactivated. Therefore, it is recommended not to change the 
performer from this page. You should do this change from the Performer List page. For 
more information, see Reassigning Assigned Tasks on page 105. 

b. To apply common values to selected instances and/or clicked instance displayed in the top 
frame, make modifications to the dataslot values displayed in the bottom frame (see Figure 75 
on page 103), and click Apply. You can also apply common values to all instances displayed 
on the screen by selecting the check box in the heading of the table in the top frame. 

c. Click Save to save the new data after your confirmation. 

To reset the form and remove the information you just entered, click Reset. To cancel the 
action and exit the current page, click Cancel.
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11.   Click Update All to apply common values to all instances displayed on all pages. A Warning 
appears, stating that all instances for the selected application will be updated and asks if you want 
to continue. You cannot undo this operation, so make sure all information is correct. Click OK and 
a Confirmation message appears, indicating the update was successful. Click OK to return to the 
Workstep List page.

12.   To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current page, click Cancel.

Resuming Suspended Worksteps

You can now resume the suspended workstep(s). To resume one workstep, a selected batch of worksteps, or 
all worksteps:

1.   In the Management module, click Instance Manager > Worksteps. The Search Worksteps page is 
displayed.

2.   The Search Worksteps page (see the following figure) contains three tabs: Search Criteria, where 
you can select one or more instances; Display Attributes, where you can choose which dataslot 
attributes will be displayed; and Worksteps, where you can select one or more worksteps.

Figure 81   Search Worksteps Page

3.   Select an application from the Application drop-down list, and click Go. 

4.   The Search Worksteps page has a format similar to the Search Instances page. Please refer to the 
procedures described in Step 2 in Updating Process Instances on page 102.

5.   Use the Search Criteria tab to specify search criteria that will locate and display worksteps of the 
selected application that meet the search criteria. 

Depending on whether you want to resume worksteps to which human performers or adapters are 
assigned, select Activity or Adapter/Agent respectively from the Workstep Type drop-down list

6.   Open the Display Attributes tab to display a list of attributes and dataslots. Select the check boxes 
for the attributes and/or dataslots that you want to change.
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7.   Open the Worksteps tab to specify the worksteps you want to locate.

8.   Click Search to retrieve all workitems that meet the search criteria you have specified.

9.   The search results are presented in the Workstep List page (see Figure 82). This page contains two 
frames: the top frame displays all worksteps selected in step 5, and identifies their associated 
instance as well as dataslots that you had selected for display in step 6. The bottom frame allows 
you to apply common values to selected dataslots. 

As seen in the top frame, worksteps are presented in a tabular format, with each row representing a 
workstep. Workstep values are represented as columns.

Figure 82   Workstep List Page 

If your search has retrieved many worksteps, they will be presented in multiple pages. To manage 
the contents of the list, you can sort them. To navigate through the pages, you can use the paging 
controls. For more details about these operations, see Exploring BPM Portal on page 21.

Note:    You can customize the number of worksteps that are displayed on a single page by modifying the 
bpmportal.conf file.

10.   In the top frame, select the worksteps whose status is to be changed to Resume. 

11.   In the bottom frame, select Active from the Status drop-down list, and then click Apply. You can 
also change the status of all instances displayed on the screen by selecting the check box in the 
heading of the table in the top frame. 

12.   Click Save to save the new data after your confirmation. 

To reset the form and remove the information you just entered, click Reset. To cancel the action and 
exit the current page, click Cancel.
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13.   Click Update All to apply common values to all instances displayed on all pages. A Warning 
appears, stating that all instances for the selected application will be updated and asks if you want to 
continue. You cannot undo this operation, so make sure all information is correct. Click OK and a 
Confirmation message appears, indicating the update was successful. Click OK to return to the 
Workstep List page.

14.   To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current page, click Cancel.
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Chapter 9

Using the Balanced 
Scorecard

Balanced Scorecard is a performance management system that enables senior management to measure how 
their organization’s business activities are helping it meet its strategic goals. Balanced Scorecard provides 
you as a ITPC Manager with a method of statistically measuring your company’s performance, using a scale 
of 0-10, resulting in a balanced, high-level view of all areas of your enterprise. 

Using the Balanced Scorecard
Balanced Scorecard enables you to by look at your strategic goals from not just one, but a range of, 
perspectives that typically include:

•   Finance. Presents data from the perspective “To succeed financially, how do we appear to our 
shareholders?”

•   Customer. Presents data from the perspective “To achieve our strategic goals, how do we appear to 
our customers?”

•   Innovation. Presents data from the perspective “To achieve our strategic goals, how are we 
sustaining our ability to change and improve?”

•   Internal. Presents data from the perspective “To satisfy our shareholders and customers, what 
business processes must we excel at?”

Each of these Balanced Scorecard Perspectives are derived from key performance indicators (KPIs) that 
provide the data that translate enterprise goals into a set of measurable objectives. For example, the Finance 
Perspective can contain such KPIs as Product Revenue, Service Revenue, Product Revenues Growth, 
Service Revenues Growth, Profit Margin and Sales Pipeline. Each of these KPIs can be assigned a weight 
that indicates its comparative significance.
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Combining ITPC and Balanced Scorecard

The Management module of BPM Portal provides business process management at the business unit or 
department level, and the Balanced Scorecard is also typically management focused, even though you can 
drill down through the organization. The combination of ITPC and Balanced Scorecard provides a unique 
business approach that enables you to compare ITPC’s business process intelligence against the 
measurement of corporate strategy achievement supplied by Balanced Scorecard. 

ITPC’s Management module enables its users to perform such Balanced Scorecard management processes 
as:

•   Establishing performance targets, either by using the predefined KPIs discussed above or by using 
the Balanced Scorecard Designer to create customized KPIs that more accurately reflect your 
organization’s requirements.

•   Integrating with external systems to collect relevant data, and effectively monitoring business 
processes through standard or customized KPIs.

•   Measure the contribution business processes are making in achieving business objectives and 
strategic goals.

Each of the Balanced Scorecard Perspectives are derived from key performance indicators (KPIs). Each of 
these KPIs can be assigned a weight that indicates its comparative significance. In the Balance Scorecard 
console view, each KPI value is displayed as a dial. This dial displays the target score along with the actual 
score for each KPI. The target score divides the circumference of the dial into two parts; the first part, that is, 
the arc from 0.0 to target score is shown in red, whereas the second part, that is, the arc from target score to 
10.0 is shown in green. The needle of the dial indicates rounded-off actual score. Optionally, the fields 
below the dial show the exact actual value and/or target score. This dial gives a visual indicator of 
achievements and help managers to track the progress.

Viewing Balanced Scorecard Applications

ITPC contains processes and rules that collate Business Scorecard data and it then inserts this data in 
infopads. ITPC enables you to view this data as a standard Balanced Scorecard application, or to design a 
customized Balanced Scorecard application. 

The user must install the Balanced Scorecard sample application, and then select Balanced Scorecard from 
the drop-down list on the Balanced Scorecard page to display the standard view seen in Figure 83 on page 
115. By default, a view of all the perspective values is displayed. 
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To view your Balanced Scorecard application:

1.   In the Management module, click Balanced Scorecard > Console and select BalancedScorecard 
from the Balanced Scorecard drop-down list to open the Balanced Scorecard page (see the figure 
below). 

Figure 83   Balanced Scorecard Page

2.   Select an option from the Balanced Scorecard drop-down list, select an option from the 
Perspective drop-down list, and then click Go to obtain information on a specific Balanced 
Scorecard Perspective. Options include All, Customer, Finance, Innovation and Internal.

3.   Edit values for each perspective by clicking the Edit icon (  ). For more information, see Editing 
Balanced Scorecard Perspectives on page 116 .
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4.   In the console view, each KPI value is displayed as a dial. Each dial is associated with a hyperlink 
to infopad analysis reports that launch a history for the selected KPI. For example, clicking the 
Product Returns dial of the Customer perspective displays the report seen in the following figure. 
Click on any of the KPI links to execute a corresponding analysis report.

Figure 84   Balanced Scorecard History

Editing Balanced Scorecard Perspectives

ITPC provides a management application interface in which the user can edit the Relative Weights for a 
specific KPI, as well as modify other values and enter a description of each KPI in the selected perspective. 
This interface is seen in Figure 85 on page 117.

For example, you can emphasize the importance of Profit Margin KPI in the Finance Perspective by 
increasing the original value of 0.2 (20%) to a value of 0.70 (70%) in the Weight column. Changing the 
relative weight of the Profit Margin KPI will change the score for the Finance Perspective, as well as the 
total Balanced Score.

Note:    The sum of the numbers in the Edit (Perspective) Relative Weights dialog window (see Figure 85) 
must not exceed 1.0.
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To edit a Balanced Scorecard value:

1.   Click the Edit icon (  ) displayed to the right of each Perspective (see Figure 83 on page 115) to 
open the Perspective Details page, as shown in the following figure.

Figure 85   Editing Balanced Scorecard Perspectives

2.   Modify the data in any of the boxes.

3.   Click Save to submit and save your changes. A Confirmation message appears, indicating the 
editing of the perspective values was successful. Click OK, and return to the Balanced Scorecard 
page.

Click Reset to delete your changes and display the original settings.

Click Cancel to delete your changes and return to the Balanced Scorecard page.

Using the Balanced Scorecard Designer
ITPC provides the Balanced Scorecard Designer, which presents a series of user interfaces where you can 
view your available Balanced Scorecard applications, modify existing Balanced Scorecards, and add a new 
Balanced Scorecard application that meets your specific requirements.
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Designing a New Balanced Scorecard

To design a new Balanced Scorecard:

1.   In the Management module, click Balanced Scorecard > Designer, to open the Balanced Scorecard 
List page (see the figure below). 

Figure 86   Balanced Scorecard List Page

All available Balanced Scorecard applications are listed, with a brief description for each of them. 

2.   To add a new Balanced Scorecard, click Add Balanced Scorecard, opening the Add Balanced 
Scorecard page (see the following figure).

Figure 87   Add Balanced Scorecard Page

a. Enter the name of the new Balanced Scorecard and its description. 

b. Click Next, opening the Perspectives List page where you can create perspectives for the new 
Balanced Scorecard. 
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3.   The Perspectives List page (see following figure) enables you to: 

Figure 88   Add Perspective Page

a. Enter a name in the Perspective box and assign the perspective a weight. 

Note:    The perspective name must not contain spaces.

b. You may add more perspective(s), if required, by clicking Add Perspective, which opens Add 
Perspective window. Enter perspective and weight and click Save to add the perspective to the 
Perspective/Weight table. 

c. Click Next, opening the Source List page where you can define sources to be used by the KPIs 
of the new Balanced Scorecard. 
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4.   The Source List page enables you to add sources of information that can be used to define KPIs and 
generate Balanced Scorecards. All KPIs must have at least one source, and Additive and Averaging 
KPIs can have multiple sources. This page displays two tables listing the Process Template Sources 
and the Infopad Sources.

Figure 89   Source List Page

5.   Click Add Source to open the Add Source window as shown in the following figure.

Figure 90   Add Source Page for New KPIs

a. Select an option from the Source Information list. Options include Process Templates or 
Infopads.

b. Enter the name of the new Source in the Source box. 

c. If the Source information comes from a process template, select options from the Process 
Template, Workstep, Event and Dataslot lists to further define the source. 

NOTE:    The Dataslot drop-down list contains numeric and string type dataslots only.

d. If the Source information comes from an infopad, specify the Application, Module, Infopad 
Name, Row, Column and Slot containing the updated value.

NOTE:    The Slot drop-down list does not contain the slots of type “String”.
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e. Click Save to save the new Source and go back to the Source List page to define additional 
sources. Depending upon whether the source information is specified as process template or 
infopad, the new source is added in the appropriate table in the Source List page.

f. Click Next, opening the KPI List page where you can define KPIs for the new Balanced 
Scorecard.

6.   The KPI List page (see following figure) displays the list of KPI. You can select a perspective from 
the drop-down list beside Go, and click Go, to list KPIs of selected perspective only. 

Figure 91   Add KPI Page

7.   From the Perspective drop-down list, select the perspective to which the new KPI is assigned, and 
click Add KPI. The Add KPI window is opened.

a. The KPI Details tab displays the name of the selected balanced scorecard and perspective in 
read only mode.

b. Enter the name of the KPI. 

Note:    The KPI Name must be unique.

c. Select a KPI type from the Type list. Options include:

• Additive, which updates the current value by adding on any updated values.

• Average, which updates the current value by averaging in any updated values.

• Replace, which replaces the current value with the updated one.

d. Enter values for each of the displayed parameters. Assign a weight -- weight values must be in 
the 0-1 range. The Current Value and Score are generally used for initialization purposes only. 
The Best Value and Worst Value are used in calculating the score. Unit is used for summary 
descriptions; longer descriptions are entered in Description. You can specify the target score 
between 0.0 and 10.0 for each KPI in the Target Score. The Balanced Scorecard Console will 
display the target score along with the actual score for each key performance indicator. It will 
give a visual indicator of achievements and help managers to track the progress. 
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e. Select the Editable check box to enable users to modify the value or the Display check box to 
create a read-only value.

f. Click Attach Source tab. This tab displays the list of available sources defined earlier and the 
list of sources attached to the KPI.

g. Select one or more available sources from the Select Sources list and click Add to add them in 
the Attached Sources list. You can click Add All to add all available sources simultaneously. 
You may use Remove or Remove All to remove the sources from the Attached Sources list 
and put them back in the Select Sources list.

h. Click Save to save the new KPI and go back to the KPI List page. The new KPI is listed in the 
table on this page.

8.   Click Finish to create the new Balanced Scorecard.

9.   A Confirmation message appears, indicating that you have successfully added a new Balanced 
Scorecard. Click OK to save it and return to the Balanced Scorecard List page.

After you have designed and saved a new Balanced Scorecard, you (or someone like ITPC Administrator, 
who has requisite access permissions) must install it as a new application from the BPM Portal's 
Administration module for it to work properly.

Generating Rules in Balanced Scorecards

Balanced Scorecard Designer automatically generates one rule file for each Balanced Scorecard. This rule 
file contains the following sections.

•   Initialization. This section creates an infopad containing the weights of the perspectives. The 
Perspective Weight infopad contains one row for each perspective in the scorecard. The lone slot in 
the cell provides the weight for that perspective, and each slot has an alarm that is triggered with the 
weight changes. This event triggers a rule that updates the overall score.
Initialization creates a dynamic infopad for the overall score, with one row created for each month. 
The lone slot in the definition cell provides the score.
Initialization also creates a dynamic infopad for each perspective, with one row for each month and 
one column for each KPI in that perspective. For more information, see Main Scorecard Group Rule.

•   Finalize. This section contains an entry for each of the infopads created that will destroy them when 
the rules are unloaded.

The rule file also contains the following rule groups:

•   Update Values. Updates the current values of the appropriate infopads. The Update Values rule 
vary depending on the KPI type and the number and type of data sources. If the KPI type is additive, 
the action adds the value of the data source to the KPI’s current value slot. If the KPI type is 
averaging, the action averages the value of the data source to the KPI’s current value slot. If the KPI 
type is replace, the action replaces the current value with the value of the data source.

•   Main Scorecard Group. Contains the escalation rules for calculation, rules that update the infopads 
when the collection process completes; and a rule that adds a row to all the dynamic infopads on the 
last day of a month and schedules the next month’s event. Cells in each infopad have an alarm that 
trigger a different update rule. Rules included in this group include:
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• Perspective BestValue Rule: Each perspective contains one best value rule, which is 
triggered when a BestValue slot has changed in a cell. It recalculates the score for the 
relevant KPI.

• Perspective WorstValue Rule: Each perspective contains one worst value rule, which is 
triggered when a WorstValue slot has changed in a cell. It recalculates the score for the 
relevant KPI.

• Perspective CurrentValue Greater Than Rule: Each perspective contains one 
CurrentValue Greater Than rule, which is triggered when a CurrentValue slot has changed, 
and the NegativeRange for that cell is ‘F’, meaning that the BestValue is greater than the 
WorstValue. The rule checks that the CurrentValue is less than BestValue; or it sets 
BestValue to the CurrentValue and checks that the CurrentValue is greater than 
WorstValue; or it sets WorstValue to the CurrentValue. It then generates an event that will 
trigger a rule to recalculate the score.

• Perspective CurrentValue Less Than Rule: Each perspective contains one CurrentValue 
Less Than rule, which is triggered when a CurrentValue slot has changed, and the 
NegativeRange for that cell is ‘T’, meaning that the BestValue is less than the WorstValue. 
The rule checks that the CurrentValue is greater than the BestValue; or it sets BestValue to 
the CurrentValue and checks that the CurrentValue is less than the WorstValue; or it sets 
WorstValue to the CurrentValue. It then generates an event that will trigger a rule to 
recalculate the score.

• Perspective CurrentValue Update Rule: Each perspective contains one CurrentValue 
Update rule, which is triggered by the event generated by the CurrentValue Greater than rule 
or the CurrentValue Less than rule. It then recalculates the score of the affected cell.

• Perspective RelativeWeight Rule: Each perspective contains one RelativeWeight rule, 
which is triggered when the relative weight slot has changed in a cell and the affected cell is 
not in the last row of the infopad. It updates the sum of the weights in the last column. Then 
it issues an event for each KPI in the perspective that will recalculate the score for each cell, 
triggering the CurrentValue Update rule. 

• Perspective Score Rule: Each perspective contains one Score rule, which is triggered when 
the score slot has changed in a cell. It then recalculates the perspective score.

• Perspective BSCard Rule: Each perspective contains one BSCard rule, which is triggered 
when the Perspective score slot has changed. It issues an event that triggers a rule to 
recalculate the main overall score.

• Perspective BizLogicUpdate Rule: Each perspective contains one BizLogicUpdate rule, 
which is triggered when the perspective subprocess W_COMPLETED event is sent. It then 
updates the CurrentValue for every KPI in the perspective.

• Perspective Weight BSCard Rule: Each perspective contains one Perspective Weight 
BSCard rule, which is triggered when the weight for a perspective has been updated. It then 
triggers a rule to recalculate the main overall score.

• Overall UpdateMainBSC Rule: Each perspective contains one UpdateMainBSC rule, 
which is triggered when perspective weights or scores change. It then updates the main 
overall score.

• AddRowsToScorecardInfoads Rule: Each perspective contains one 
AddRowsToScorecardInfopads rule, which is triggered when the scheduled event is sent. 
For each of the dynamic infopads (i.e., each of the perspective infopads and the main 
scorecard infopad), a row is added and the values from the previous row are copied into the 
new row. Finally, an event is scheduled to trigger the rule on the last day of the next month.
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Viewing and Modifying Existing Balanced Scorecards

If you modify an existing Balanced Scorecard, to view the changes, you (or ITPC Administrator) must 
reinstall the modified Balanced Scorecard. 

To access or modify existing Balanced Scorecard applications:

1.   In the Management module, click Balanced Scorecard > Designer, to open the Balanced Scorecard 
List page (see the figure below), where all existing Balance Scorecards are listed. 

Figure 92   Balanced Scorecard List Page

To delete a Balanced Scorecard from those listed on the Balanced Scorecard List page, select a 
Balanced Scorecard from the list and click Delete.

To copy a Balanced Scorecard and save it as a new Balanced Scorecard, click Save Balanced 
Scorecard Copy....

2.   Click the name of the balanced scorecard in the Balanced Scorecard column to view or modify the 
corresponding Balanced Scorecard, opening the Add Balanced Scorecard page (see Figure 87 on 
page 118).

• Change the name of the new Balanced Scorecard and/or its description. 

3.   Click Next, opening the Perspectives List page (see Figure 88 on page 119) where you can modify 
perspectives of the Balanced Scorecard. 

To delete a Perspective from those listed on the Perspectives List page, select a Perspective from 
the list and click Delete. You can add new perspectives, and/or edit names/weights of the existing 
perspectives.

4.   Click Next, opening the Source List page where you can modify sources used by the KPIs of a 
Balanced Scorecard.

To delete a Source from those listed on the Source List page, select a Source from the list and click 
Delete. You can add new sources, and/or edit details of the existing sources.

5.   Click Next, opening the KPI List page (see Figure 91 on page 121) where you can modify KPIs of 
the Balanced Scorecard. 
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To delete a KPI from those listed on the KPI List page, select a KPI from the list and click Delete. 
You can add new KPIs, and/or edit details of the existing KPI.

6.   Click Finish to save the current scorecard. 
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Chapter 10

Using the Infopad Manager

An infopad is a table, composed of elements called cells, that store such global data as application 
parameters (e.g., a list of e-mail addresses of persons to notify) or rule parameters (e.g., the critical threshold 
for a resource load). Each cell is a data structure made up of slots, or attributes, that in turn contain 
slotnames and values. The Infopad Manager enables you to edit the information provided in an infopad.

Modifying Infopad Values
To use Infopad Manager to modify infopad values:

1.   In the Management module, click Infopads, to view the Infopads page. 

2.   Select the application from the Application drop-down list, then select the infopad you want to edit 
from the Infopad drop-down, and click Go. Names of the selected Application and Infopad are 
displayed below the selection bar.

3.   In case of multidimensional infopads, an infopad cell is located in a specific row and column. 
Specify whether the infopad is to be sliced on row or column by selecting appropriate option. 
Depending on this selection, select the row/column from the drop-down list and click Go.
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After selecting a cell, the slotnames and their values within that cell appear below (see the 
following figure).

Figure 93   Infopads Page

4.   Edit the values in the cell by changing the values in the text boxes in the Column.

5.   Click Save to save your changes. BPM Portal saves your changes after your confirmation. 

To reset the form and remove the information you just entered, click Reset. 

Note:    For more information on infopads, see the Infopads chapter in the BizPulse User’s Guide.

Exporting Infopads
You can export business metrics and Balanced Score Cards into different formats for creating reports and 
documentation. To do so, follow these steps:

1.   In the Management module, click Infopads, to view the Infopads page. 

2.   Select the application from the Application drop-down list, then select the infopad you want to edit 
from the Infopad drop-down, and click Go. 

3.   Select the format in which you want to export this data from the Export Type drop-down list. You 
can choose one of the HTML, XML or XLS formats. Click Export. 

BPM Portal displays the infopads and their values in the specified format.
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Appendix A

Predefined Reports

ITPC enables you to run a series of predefined reports that are based on selections you make from the 
following criteria:

•   Report type. In the submenu options under the Reports menu, choose from the Status Analysis, 
Time Analysis or Workload Analysis report types. The Time Analysis option, for example, enables 
you to run a report based on time factors.

•   Analysis type. In the Analysis for: drop-down list, select whether you want to execute a report based 
on Instance, Performer or Workstep.

•   Application type. In the Applications drop-down list, select All to run a report for all installed 
applications, or select a specific application.

•   Subcriteria based on Report type. 

• If you selected a Status Analysis report type, and analyze it for an Instance, a Status 
drop-down list is displayed that contains the following Status options: All, Active, 
Completed, Removed and Suspended, whereas if you analyze it for a Workstep, the Status 
drop-down list contains the following Status options: All, Active, Completed and 
Suspended. In the Date drop-down list, select a predefined interval (e.g., All, Today, This 
Week, Last Month, etc.) or enter Start and End dates in the From: and To: boxes, 
respectively.

• If you selected a Time Analysis report type, a Time Analysis drop-down list is displayed 
that contains the following options: Completion Time (time of actual or estimated 
completion), Elapsed Time (the interval between start and current time—when a workstep is 
not yet completed and not overdue), Overdue Time (the amount of delay from the scheduled 
end time up to the current time for a workstep which is not yet completed and is overdue) 
and Estimated vs Elapsed Time. In the Date drop-down list, select a predefined interval 
(e.g., All, Today, This Week, Last Month, etc.) or enter Start and End dates in the From: and 
To: boxes, respectively.

• If you selected a Workload Analysis report type, a Workload Type drop-down list is 
displayed that contains the following options: Today’s Tasks (i.e., all tasks due the present 
day and overdue) or Due Today.

NOTE:    While filtering based on the date, only the starting date is considered.
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The following section provides examples of reports that you can create based on criteria described above.

Creating Status Analysis Reports
To create a status analysis report that shows the total instances for each status (Active, Completed, 
Suspended, Removed) for the Assign_A_Task_Ver1 application:

1.   In the Management module, click Reports > Status Analysis, to view the Status Analysis page, as 
shown in the following figure. 

2.   Select:

• Instance from the Analysis for: drop-down list.

• Assign_A_Task_Ver1 from the Applications list.

• All from the Status list.

• All from the Subprocess list.

3.   Select a predefined interval from the Date drop-down list (e.g., All, Today, This Week, Last Month, 
etc.) or enter Start and End dates in the From: and To: boxes, respectively. Click the Select Date 
icon ( ) to facilitate entering a date.

4.   Click Go, and the report appears in the workspace, as seen in the figure below.

Figure 94   Status Analysis Report for All Instances for Assign_A_Task_Ver1 Application

5.   Select the preferred format from the Report Format drop-down list and click View to view the 
report in a specific format.

6.   Click Email... to open the Email Report dialog box (see the following figure). Enter information in 
the relevant boxes and select a format from the Report Format drop-down list.
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NOTE:    If you select HTML, the report mail is sent as an HTML formated email, whereas if you 
select HTMLFile, the report is sent as an attachment in HTML format. If your mail-tool 
supports mails in HTML format, you can view the HTML report in your mail-tool. But if your 
mail-tool supports mails only in text format, you cannot view the HTML report. However, you 
can view it as an attachment, if it is sent as an HTMLFile.

Figure 95   Email Report Dialog Box

7.   Click Submit to email the report. 

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current dialog box, click Close.

Example

To create a report that shows the status of all completed worksteps for the Assign_A_Task_Ver1 
application:

1.   In the Management module, click Reports > Status Analysis, to view the Status Analysis page, as 
shown in the following figure. 

2.   Select:

• Workstep from the Analysis for: drop-down list.

• Assign_A_Task_Ver1 from the Applications list.

• Completed from the Status list.

• All from the Subprocess list.

3.   Select a predefined interval from the Date drop-down list (e.g., Today, This Week, Last Month, 
etc.) or enter Start and End dates in the From: and To: boxes, respectively. Click the Select Date 
icon ( ) to facilitate entering a date.
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4.   Click Go, and the report appears in the workspace, as seen in the figure below.

Figure 96   Status Analysis Report for Completed Worksteps for Assign_A_Task_Version1

5.   Select the preferred format from the Report Format drop-down list and click View to view the 
report in a specific format.

6.   Click Email... to open the Email Report dialog box (see Figure 95). Enter information in the 
relevant boxes and select a format from the Report Format drop-down list. 

7.   Click Submit to email the report. 

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current dialog box, click Close.

Creating Time Analysis Reports
To create a time analysis report that shows the completion time for all instances of all applications:

1.   In the Management module, click Reports > Time Analysis, to view the Time Analysis page, as 
shown in the following figure. 

2.   Select:

• Instance from the Analysis for: drop-down list.

• All from the Applications list.

• Completion Time from the Analysis Time list.

3.   Select a predefined interval from the Date drop-down list (e.g., All, Today, This Week, Last Month, 
etc.) or enter Start and End dates in the From: and To: boxes, respectively. Click the Select Date 
icon ( ) to facilitate entering a date.
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4.   Click Go, and the report appears in the workspace, as seen in the figure below.

Figure 97   Time Analysis Report for Completion Time of Instances for All Application

5.   Select the preferred format from the Report Format drop-down list and click View to view the 
report in a specific format.

6.   Click Email... to open the Email Report dialog box (see Figure 95). Enter information in the 
relevant boxes and select a format from the Report Format drop-down list. 

7.   Click Submit to email the report. 

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current dialog box, click Close.

Example

To create a report that shows the elapsed time (i.e., the interval between start and current time—when a 
workstep is not yet completed and not overdue) for all active worksteps of all applications:

1.   In the Management module, click Reports > Time Analysis, to view the Time Analysis page, as 
shown in the following figure. 

2.   Select:

• Workstep from the Analysis for: drop-down list.

• All from the Applications list.

• Elapsed Time from the Analysis Time list.

3.   Select a predefined interval from the Date drop-down list (e.g., All, Today, This Week, Last Month, 
etc.) or enter Start and End dates in the From: and To: boxes, respectively. Click the Select Date 
icon ( ) to facilitate entering a date.
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4.   Click Go, and the report appears in the workspace, as seen in the figure below.

Figure 98   Time Analysis Report for Elapsed Time for All Application Worksteps

5.   Select the preferred format from the Report Format drop-down list and click View to view the 
report in a specific format.

6.   Click Email... to open the Email Report dialog box (see Figure 95). Enter information in the 
relevant boxes and select a format from the Report Format drop-down list. 

7.   Click Submit to email the report. 

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current dialog box, click Close.

Creating Workload Analysis Reports
To create a workload analysis report that lists all instances of all applications that are overdue or due on the 
current day:

1.   In the Management module, click Reports > Workload Analysis, to view the Workload Analysis 
page, as shown in the following figure. 

2.   Select:

• Instance from the Analysis for: drop-down list.

• All from the Applications list.

• Today’s Tasks from the Workload Type list.
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3.   Click Go, and the report appears in the workspace, as seen in the figure below.

Figure 99   Workload Analysis Report for All Due or Overdue Application Instances

4.   Select the preferred format from the Report Format drop-down list and click View to view the 
report in a specific format.

5.   Click Email... to open the Email Report dialog box (see Figure 95). Enter information in the 
relevant boxes and select a format from the Report Format drop-down list. 

6.   Click Submit to email the report. 

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current dialog box, click Close.

Example

To create a workload analysis report that lists all performers that are responsible for tasks for the 
Approval_Ver2 application that are due on the current day:

1.   In the Management module, click Reports > Workload Analysis, to view the Workload Analysis 
page, as shown in the following figure. 

2.   Select:

• Performer from the Analysis for: drop-down list.

• Assign_A_Task_Ver1 from the Applications list.

• Due Today from the Workload Type list.
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3.   Click Go, and the report appears in the workspace, as seen in the figure below.

Figure 100   Workload Analysis Report for All Performers with Tasks Due in Assign_A_Task_Ver1

4.   Select the preferred format from the Report Format drop-down list and click View to view the 
report in a specific format.

5.   Click Email... to open the Email Report dialog box (see Figure 95). Enter information in the 
relevant boxes and select a format from the Report Format drop-down list. 

6.   Click Submit to email the report. 

To reset the form and remove the information you just entered, click Reset. To cancel the action 
and exit the current dialog box, click Close.

Report Examples
Examples of other reports that you can create in the Reports menu in the Management module are listed in 
the following table.

Table 21   Report Examples

Report Name Report Criteria Description
Status of Instances for All 
Applications

Status Analysis report type, with:

• Analysis for: Instance

• Application: All

• Status: All

This report shows the total instances for 
each status (Active, Completed, 
Suspended, Removed) for all applications.

Active Status of Instances 
for All Applications

Status Analysis report type, with:

• Analysis for: Instance

• Application: All

• Status: Active

This report shows the total Active instances 
for all applications, and a summary of total 
specific status instances.
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Status of Instances for (a 
specific) Application

Status Analysis report type, with:

• Analysis for: Instance

• Application: Hiring

• Status: All

This report shows the total instances for 
each status (Active, Completed, 
Suspended, and Removed) for a specific 
application—in this case, Hiring.

Active Status of Instances 
for (a specific) 
Application

Status Analysis report type, with:

• Analysis for: Instance

• Application: Hiring

• Status: Active

This report shows the total instances for a 
specific status (Active, Completed, 
Suspended, or Removed) for a specific 
application—in this case, Hiring, and a 
summary of total specific status instances.

Instance Completion 
Time Report for All 
Applications

Time Analysis report type, with:

• Analysis for: Instance

• Application: All 

• Analysis Time: Completion 
Time

This report shows the minimum, maximum, 
average and standard deviation of the 
completion time for all instances for all 
applications.

Instance Completion 
Time Report for (a 
specific) Application

Time Analysis report type, with:

• Analysis for: Instance

• Application: Hiring

• Analysis Time: Completion 
Time

This report shows the minimum, maximum, 
average and standard deviation of the 
completion time for all instances for a 
specific application—in this case, Hiring.

Instance Elapsed Time 
Report for All 
Applications

Time Analysis report type, with:

• Analysis for: Instance

• Application: All

• Analysis Time: Elapsed Time

This report shows the minimum, maximum, 
average and standard deviation of the 
elapsed time (duration) for all instances for 
all applications.

Instance Elapsed Time 
Report for (a selected) 
Application

Time Analysis report type, with:

• Analysis for: Instance

• Application: Hiring

• Analysis Time: Elapsed Time

This report shows the minimum, maximum, 
average and standard deviation of the 
elapsed time (duration) for all instances for 
a specific application—in this case, Hiring.

Instance Overdue Time 
Report for All 
Applications

Time Analysis report type, with:

• Analysis for: Instance

• Application: All

• Analysis Time: Overdue Time

This report shows the minimum, maximum, 
average and standard deviation of the 
overdue time for all overdue instances for 
all applications.

Workstep Completion 
Time Report for All 
Applications

Time Analysis report type, with:

• Analysis for: Workstep

• Application: All

• Analysis Time: Completion 
Time

This report shows the minimum, maximum, 
average and standard deviation of the 
completion time for all worksteps for all 
applications.

Workstep Completion 
Time Report for (a 
specific) Instance

Time Analysis report type, with:

• Analysis for: Workstep

• Application: Hiring

• Analysis Time: Completion 
Time

This report shows the minimum, maximum, 
average and standard deviation of the 
completion time for all worksteps for a 
specific application—in this case, Hiring.
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Workstep Elapsed Time 
Report for All 
Applications

Time Analysis report type, with:

• Analysis for: Workstep

• Application: All

• Analysis Time: Elapsed Time

This report shows the minimum, maximum, 
average and standard deviation of the 
elapsed time (duration) for all worksteps for 
all applications.

Workstep Overdue Time 
Report for All 
Applications

Time Analysis report type, with:

• Analysis for: Workstep

• Application: All

• Analysis Time: Overdue Time

This report shows the minimum, maximum, 
average and standard deviation of the 
overdue time for all overdue worksteps for 
all applications.

Workstep Overdue Time 
Report for (a specific) 
Application

Time Analysis report type, with:

• Analysis for: Workstep

• Application: Hiring

• Analysis Time: Overdue Time

This report shows the minimum, maximum, 
average and standard deviation of the 
overdue time for all overdue worksteps for a 
specific application—in this case, Hiring.

Performer Completion 
Time for All Applications

Time Analysis report type, with:

• Analysis for: Performer

• Application: All

• Analysis Time: Completion 
Time

This report shows the minimum, maximum, 
average and standard deviation of the 
completion time for all performers for all 
applications.

Performer Completion 
Time for (a specific) 
Application

Time Analysis report type, with:

• Analysis for: Performer

• Application: Hiring

• Analysis Time: Completion 
Time

This report shows the minimum, maximum, 
average and standard deviation of the 
completion time for all performers for a 
specific application—in this case, Hiring.

Performer Elapsed Time 
Summary for All 
Applications

Time Analysis report type, with:

• Analysis for: Performer

• Application: All

• Analysis Time: Elapsed Time

This report shows the minimum, maximum, 
average and standard deviation of the 
elapsed time for all performers for all 
applications.

Performer Elapsed Time 
Summary for (a specific) 
Application

Time Analysis report type, with:

• Analysis for: Performer

• Application: Hiring

• Analysis Time: Elapsed Time

This report shows the minimum, maximum, 
average and standard deviation of the 
elapsed time for all performers for a specific 
application—in this case, Hiring.

Estimated vs Elapsed 
Time for All Instances

Time Analysis report type, with:

• Analysis for: Instance

• Application: All

• Analysis Time: Estimated vs 
Elapsed Time

This report shows the minimum, maximum, 
average and standard deviation of the 
estimated vs elapsed time for all instances 
for all applications.

Estimated vs Elapsed 
Time for All Tasks

Time Analysis report type, with:

• Analysis for: Performer

• Application: All

• Analysis Time: Estimated vs 
Elapsed Time

This report shows the minimum, maximum, 
average and standard deviation of the 
estimated vs elapsed time for all performers 
for all applications.
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Estimated vs Elapsed 
Time for All Worksteps

Time Analysis report type, with:

• Analysis for: Workstep

• Application: All

• Analysis Time: Estimated vs 
Elapsed Time

This report shows the minimum, maximum, 
average and standard deviation of the 
estimated vs elapsed time for all worksteps 
for all applications.

Performer Overdue Time 
for All Applications

Time Analysis report type, with:

• Analysis for: Performer

• Application: All

• Analysis Time: Overdue Time

This report shows the minimum, maximum, 
average and standard deviation of the 
overdue time for all performers for all 
applications.

Performer Overdue Time 
for (a specific) 
Application

Time Analysis report type, with:

• Analysis for: Performer

• Application: Hiring

• Analysis Time: Overdue Time

This report shows the minimum, maximum, 
average and standard deviation of the 
overdue time for all performers for a specific 
application—in this case, Hiring.

Overdue Time for All 
Active Instances

Time Analysis report type, with:

• Analysis for: Instance

• Application: All

• Analysis Time: Overdue Time

This report shows the minimum, maximum, 
average and standard deviation time for all 
overdue instances for all applications.

Completion Time for (a 
specific) Application 
Instances

Time Analysis report type, with:

• Analysis for: Instance

• Application: Approval

• Analysis Time: Completion 
Time

• Date: This week to date

This report shows the minimum, maximum, 
average and standard deviation time for all 
instances of a specific application 
completed in the past week. 

Assigned Performers for 
All Applications 

Status Analysis report type, with:

• Analysis for: Performer

• Application: All

• Status: Active

This report shows all the active tasks from 
all applications for each performer.

Tasks Completed by a 
Performer in the Current 
Week

Status Analysis report type, with:

• Analysis for: Performer

• Application: All

• Status: Completed

• Date: This week to date

This report shows all the tasks from all 
applications completed in the current week 
by a specific performer.

Suspended Performers 
for All Applications

Status Analysis report type, with:

• Analysis for: Performer

• Application: All

• Status: Suspended

This report shows the total suspended 
instances for all applications for a specific 
performer for the selected time period.
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Suspended Performers 
for (a specific) 
Application

Status Analysis report type, with:

• Analysis for: Performer

• Application: Approval

• Status: Suspended

This report shows the total suspended 
instances for a specific application for a 
specific performer for the selected time 
period.

Total Elapsed Time of All 
Active Instances

Status Analysis report type, with:

• Analysis for: Instance

• Application: All

• Status: Active

This report shows the total elapsed time of 
all the active instances from all applications. 

All Completed Instances 
for Today

Status Analysis report type, with:

• Analysis for: Instance

• Application: All

• Status: Completed

This report shows all the instances 
completed today from all applications .

Active Instances of (a 
specific) Application in 
each Workstep

Status Analysis report type, with:

• Analysis for: Workstep

• Application: Approval

• Status: Active

This report shows all active instances in 
each workstep of a specific application (in 
this case, Approval).

Time taken by (a specific) 
Application to complete 
each worksteps

Status Analysis report type, with:

• Analysis for: Workstep

• Application: Approval

• Status: Completed

This report shows the time taken by all 
instances of a specific application to 
complete each workstep. 

All Tasks for All 
Performers Due Today

Workload Analysis report type, 
with:

• Analysis for: Performer

• Application: All

• Workload Type: Due Today

This report shows all today’s tasks from all 
applications for all performers .

All Instances Due or 
Overdue Today

Workload Analysis report type, 
with:

• Analysis for: Instance

• Application: All

• Workload Type: Today’s 
Tasks

This report shows all the instances of all 
applications for all performers for today.

Tasks for Each Performer 
Due or Overdue Today

Workload Analysis report type, 
with:

• Analysis for: Performer

• Application: All

• Workload Type: Today’s 
Tasks

This report shows all the instances for each 
performer for today.
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Glossary

This is a listing of common ITPC terminology. For a full version of terms used in IT Process Centre (ITPC) 
documentation, refer to the Terminology Guide in the ITPC_HOME\docs folder.

A | B | C | D | E | G | H | I | K | M | P | R | S | T | U | W

ACL Manager
In EMC BusinessManager (EBM), Access Control List Manager provides a finer, more precise control over user 
access rights for resources and actions. 

Activity Workstep
In ITPC, the basic unit of work; must be performed by one or more human performers (valid individual user, multiple 
users or user group).

Adapter
A Java class that integrates remote, third party classes and actions with ITPC. An adapter can automate certain 
functions and tasks performed by a remote server or other external systems. 

Administration
A module in BPM Portal enabling the administrator to perform such tasks as installing/uninstalling applications, 
modifying configuration parameters controlling ITPC operations, and manage ITPCITPC users, groups and access 
control.The Administration module is visible only to ITPC users who have permissions to access it.

Application
In ITPC, an application is an installed, executable business process that automates a business flow.
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Balanced Scorecard
A management application in the Management module that measures performance by analyzing how an 
organization’s business activities help it achieve its strategic goals. The Balanced Scorecard provides an analysis 
from a range of perspectives.

BAM
Business Activity Management combines Business Process Management with strategic and analytical information on 
specific business performance indicators, providing real-time status information and identifying critical events to 
assist senior management in making informed business decisions.

BizLogic
An ITPC component that provides a flexible, lightweight, scalable workflow process engine for intranets, extranets, 
and the Internet.

BizPulse
an ITPC component that provides an open event-driven rule engine to formulate and enforce policies in business 
applications.

BizSolo 
an ITPC component that enables users to develop customizable, sophisticated presentation flows for business 
processes, install them as Web applications, and execute them on their Web browsers.

BizStore
An open repository of rich e-business information collected from different ITPC modules.

BPEL
BPEL (Business Process Execution Language) for Web services is an XML-based language designed to enable 
task-sharing for a distributed computing or grid computing environment - including across multiple organizations - 
using a combination of Web services. 

BPMN
BPMN (Business Process Modelling Notation) provides businesses with the capability of defining and understanding 
their internal and external business procedures through a Business Process Diagram giving organizations the ability 
to communicate these procedures in a standard manner.

BPM Portal
an ITPC component that offers users, managers, administrators and developers a unified, customizable portal for 
single sign-on access to all ITPC functionalities to which they are granted permission.

BPM Studio
an ITPC component that is an Integrated Development Environment for ITPC and enables ITPC users to develop and 
deploy an ITPC application without leaving the development environment. 

Business Calendar
an ITPC feature that accurately calculates the Due Date of tasks, and provides support for multiple business calendars 
across different time zones. 
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Business Flow
The logical sequence of process activities, related to one another by a triggering activity, to achieve an outcome. It 
represents a business process that begins with a commitment and ends with the termination of that commitment. In 
ITPC, business flow includes workflow (the flow of all human-performed activities), integration flow (the flow of 
activities performed by systems) and presentation flow (from a user’s viewpoint, the flow of data from one Web page 
to the next).

Business Logic
The control flow and information flow among worksteps that define a business process.

Business Object
A representation of an activity in the business domain, including its name, definition, attributes, behavior, 
relationships and constraints. 

Business Process
A process involving multiple worksteps in the form of operations, interactions and notifications performed by a user, 
group of users, an external adapter, or a script. Examples of internal business processes are purchasing, expense 
reporting, help desk, and time card. External processes may include order processing, sales, and customer service.

Business Process Management
The concept of guiding work activities through a multi-step business process in order to improve performance and 
reduce costs within and across functional business units.

Business Rule
A combination of elements, including validation edits, logon verifications, database lookups, policies and 
transformations, that represent an enterprise’s way of doing business.

Cluster
In ITPC, an integrated set of multiple, electronically connected but physically separated servers. This loosely coupled 
group of nodes collaborate to provide shared access to the services that each node hosts. To other systems, the cluster 
appears as a single system.

Control Flow
The sequences of worksteps and workstep conditions, as defined in a process template in BPM Studio or Process 
Modeler.

Dashboard
an ITPC feature that provides a graphic overview of the status of several business processes on a single Web page, 
enabling users to monitor the progress of each process. Users can view business processes across all applications or 
for a selected application.

Dataslot
A data placeholder that persists through the entire process and defines the information flow of the business process. 
Dataslots are associated with processes, where they can add information into (Input type) or out of (Output type) 
worksteps, and appear as editable or read-only fields on a user’s interface.

Expression Editor
an ITPC tool that enables users to define complex conditional expressions within a Decision workstep to support their 
business requirements.
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Group
In ITPC, an entity that has as members valid users or other groups who perform related work and have authorized 
access to specific components.

Heatmap
an ITPC feature that provides a convenient, graphical tool for managers to visually locate the bottlenecks in the 
process execution. It helps managers to get an overview of the status of the currently active instances, identify 
suspended instances, and analyze the history of the completed instances.

Home
A module in BPM Portal through which users interact with ITPC. Using the Home module, users complete entries to 
various tasks and applications, update profile, set preferences, and link to the support infrastructure required to 
achieve these tasks. The Home module is the primary interface for ITPC application users.

Infopad 
In ITPC, a data structure used to capture business metrics, typically displayed as a table with one or two dimensions.

Instance
An individual object within a specific class. In ITPC, a self-contained unit that is created each time you use a process 
template to run an ITPC application.

ITPC Application
An application is an implementation of a business process. It can contain one or more process templates, performers, 
adapters, customized forms or rules. An application can be deployed, installed and run on BizLogic servers. 
In ITPC, an application is an installed, executable business process that automates a workflow.

ITPC Web Services
an ITPC component that allows ITPC application developers to; a) publish their applications as Web Services, and b) 
find and convert other available Web Services on the Internet into ITPC applications.

KPI
Key Performance Indicator, used in the Balanced Scorecard system, that provides the data translating enterprise goals 
into a set of measurable objectives.

Management 
A module in BPM Portal enabling the managers to query, report, and control processes and resources for users of 
ITPC. The Management module is visible only to ITPC users who have permissions to access it.

Managed Adapter 
In ITPC, a Managed Adapter is an implementation of an adapter interface that facilitates data exchange between 
ITPC processes and external applications.

Migration
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The process of moving from the use of one operating environment to another operating environment that is typically 
seen as improvement. Migration can involve moving to new hardware, new software, or both. It may involve a new 
application, another type of database, or a redesigned network. Migration is also used to refer simply to the process of 
moving data from one storage device to another. ITPC supports data migration as well as application migration.

PAM
Process Asset Management recognizes that a company’s processes are a unique asset and provides a structure that 
organizes, stores, and secures process data, enabling users to retrieve information on any of the company’s processes.

Performer
An entity that executes a workstep. Depending on the workstep type, the performer can be a human user, a group of 
users, an adapter or other external performer, or a script.

Presentation Flow
The flow of information and user input from one interface to the next. Typically related to a single Activity workstep 
in the process and generated in a BizSolo environment.

Process Engine
Orchestrates the execution of business processes and also coordinates conversations among process engines based on 
public processes, which forms the backbone of global business collaboration.

Process Modeler
A stand-alone component that enables users to design templates for basic business processes and store or retrieve 
them from the EMC central process repository, and to design and run simulations of processes.

Process Refresh
an ITPC feature for replacing the installed process without versioning, facilitating the running process instances to 
refresh and seamlessly adapt to the new workflow.

Process Repository
A central place (can contain several databases) in which a group of processes is stored and maintained in an organized 
way, and can be accessed to retrieve information.

Process Template
In ITPC, a model of business flow that includes worksteps, connectors and dataslots. After users deploy and install it 
as an application in the ITPC directory structure, they can use the application to create process instances.

Rollback
In ITPC, a feature that restarts the workflow from a workstep previously selected as the rollback point in the process, 
performed automatically in the event of a failure. 

Role
The actions and activities assigned to a valid ITPC user who is a member of a group. In ITPC, only members of a 
group can be assigned a role. A role indicates the relationships of the user in a group context.

Rule Wizard
An interactive utility that enables ITPC users to quickly develop rules that can be applied to a business process.

Swim Lanes

P Go to Top

R Go to Top

S Go to Top
Glossary 144 Glossary



Used in workflow diagrams to organize complex processes across functional boundaries. For example, seen as 
horizontal lines on a process map, swim lanes can be used to place individual task steps into different categories that 
depend on task ownership.

Task
In ITPC, a performer is assigned one or more workitems that the performer sees as tasks. There are two types of 
tasks: Assigned, which are assigned specifically to you; and Available, which are available to be performed by you or 
other members of your user group.

User
In ITPC, a valid human performer with authorized access to specific modules. 

Workflow
The logical sequence of activities performed by human performers, typically in a BPM Studio or Process Modeler 
environment. Workflow includes the tasks, procedural steps, organizations or people involved, required input and 
output information, and tools needed for each activity in a business process.
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